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About Infor Factory Track

Infor Factory Track is a comprehensive manufacturing, labor, and attendance operations and collection
system. The application directly integrates to your ERP system, streaming up-to-date information directly to
and from the shop floor. Infor Factory Track consists of three modules integrated directly into Infor LN:

• Infor Time Track
• Infor Warehouse Mobility
• Infor Shop Floor

Contacting Infor
If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and create
a support incident.

For the latest documentation, go to Documentation Central at docs.infor.com. We recommend that you check
this website periodically for updated documentation. If you have comments about Infor documentation,
contact documentation@infor.com.
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Chapter 1: Overview

This module includes topics that describe Infor Factory Track features for LN and how to use the transactions
and forms.

Accessing Warehouse Mobility Transactions
You can access Warehouse Mobility transactions using a Web browser. Use these URL paths to access the
transactions for these two modules:

• Warehouse Mobility standard menu: http://<utility server
name>/wswebclient/Mobile.aspx?page=light&form=WMMenu.mobi

• Warehouse Mobility icon-based menu:
http://<utilityservername>/WSWebClient/mobile.aspx?page=light&form=FTICONMenu.mobi

• Warehouse Mobility number-based menu:
http://<utilityservername>/WSWebClient/mobile.aspx?page=light&form=FTICONMenuStatic.mobi

Note:  You must update these URL paths with the name of your utility server.

If you are using Warehouse Mobility on a mobile scanner device, you must configure the device to point to
one of the Warehouse Mobility menu paths: The standard menu is optimized for navigation using the directional
keys on your device, while the icon-based menu is optimized for navigation using touch input.

If the mobile scanner has limited display space, you can add (SETVARVALUES(DisplayMobileToolbar=none))
parameter to the URL to view the More option. See Using the More option.

Single Sign-On (SSO)

The Warehouse Mobility forms can be accessed using IFS SSO. The Single Sign-On (SSO) functionality allows
you to execute Warehouse Mobility processes centrally, without the deployment in Infor Ming.le. All the
standard user management task can be performed at a central location in Ming.le. The user information is
published by Ming.le as a BOD to update the data in the Factory Track application. See Single Sign-On URL
for Warehouse Mobility on page 9.

Single Sign-On URL for Warehouse Mobility
You must use this URL pattern, if IFS is installed on a specific device:
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https://usalvwft60110db.infor.com/WSWebClientIFS/Default.aspx?page=light&form=FTIconMenu.mobi
&useWorkstation=1&config=FT7MG10304_DEMO&ForceSSO=1&IOS=usalvwwmxi01.infor.com.

The URL components include:

• https://usalvwft60110db.infor.com/: Indicates the Factory Track server.
• WSWebClientIFS: The Web Client configured for IFS validation.
• Default.aspx?page=light&form=FTIconMenu.mobi: Indicates the standard WM address.
• useWorkstation=1: Indicates that the login credential of the workstation user must be considered instead

of allowing the operator to enter a user name and password.
• config=FT7MG10304_DEMO: Indicates the Factory Track configuration that is accessed.
• ForceSSO=1: Indicates that the SSO functionality is enabled.
• IOS=usalvwwmxi01.infor.com: Indicates the IFS location.
Note: The Warehouse Mobility user is automatically logged out of Infor OS when logging out from the Factory
Track application. This results in the standard Ming.le login form being displayed which enables another user
to login.

You must use this URL pattern, if IFS is in the cloud:

https://ft7a.ft.awsdev.infor.com/WSWebClient/default.aspx?tenant=FTK7LN3_DEM&config=FTK7LN3_DEM_LN
&ConfigGroup=FTK7LN3_DEM&page=light&form=FTICONMenu.mobi&notitle=none&forcesso=1
&IOS=qac-sso.qac.awsdev.infor.com&Mode=cloud.

The URL components include:

• tenant=FTK7LN3_DEM: Indicates the tenant in the cloud.
• ConfigGroup=FTK7LN3_DEM: Indicates the configuration group which the configuration belongs to, in

the cloud.
• Mode=cloud: Indicates the cloud-based installation and hence, ping federate is used for IFS validation.
Note: The Warehouse Mobility user is automatically logged out of Infor OS when logging out from the Factory
Track application. This results in the standard Ming.le login form being displayed which enables another user
to login.

You can use this URL pattern, if IFS is used for user control:

https://usalvwft60110db.infor.com/WSWebClientNOIFS/Default.aspx?page=light&form=FTIconMenu.mobi.

The URL components include:

• https://usalvwft60110db.infor.com/: Indicates the Factory Track server.
• WSWebClientNOIFS: The Web Client configured for IFS validation.
• Default.aspx?page=light&form=FTIconMenu.mobi: Indicates the standard WM address.

Copy Site Data Process
You can copy the Factory Track master data from one site (environment) to another using the Export and
Import process. This process is generally used to copy the development setup to production during the
implementation process. The Export Site Data form is used to extract the data to an XML file from the source
environment. The Import Site Data form is used to import this XML file into the destination environment.
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The data that is copied comprises of these categories:

• Technical Master Data: The database table that consists of technical data such as parameters, menus,
groups, account authorizations and so on.

• Factory Track Application Master Data: Includes Factory Track Application Master data such as shifts,
employee types and so on, which is set up primarily for the Time Track module.

• ERP Application Master Data: Includes the data related to employees, departments, work centers, and
so on. This data is downloaded from the ERP. The data that is not specified in ERP but collated using the
data in ERP, such as Worksets is also exported.

• User Data: Includes user account information that is stored in the site.

Export Site Data form
Use the Export Site Data form to export the site data to an XML file.

To export the XML file:

1 Open the Export Site Data form.
2 Specify this information:

Export File Name
The XML file used to export the specified data.
Note: This value is defaulted. However, you can modify this value.

From Site
The name of the site you access. The data is exported from this site.
Note: This value is defaulted.

Technical Master Data
Indicates that the technical data such as parameters, menus, groups, account authorizations, and so
on, is exported. By default, this check box is selected.

FactoryTrack Application Master Data
Select this check box to export the application master data such as employee types, shifts, and so on.

ERP Application Master Data
Select this check box to export the data from ERP. The data such as employees, departments, work
centers, and so on, is exported.

Include Transaction Data
Select this check box to export the transactional information.
Note: If this checkbox is selected, the administrator can specify a start date, an end date and employee
information to indicate the specific transactional data that must be exported.

Include Users
Select this check box to export the transactional information.

From Date
The Start Date used to determine the transactional data that must be exported.
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To Date
The End Date used to determine the transactional data that must be exported.

Employee
The From and To fields define the range of employee IDs. The data for this specified range of employees
is exported. You can also export the transactional data for a specific employee.

Anonymize
Select this checkbox to mask the employee related information in compliance with the GDPR.

3 Click Generate to export the data to an XML file.

Import Site Data form
Use the Import Site Data form to import the data from the XML file.

To import an XML file:

1 Open Import Site Data form.
2 Click Import XML to browse and select the XML file.
3 Click Upload
4 Review and specify this information:

From Site
The name of the site to which the data is imported.
Note: This value is defaulted. Before the process of copying the data is initiated, the existing data in this
site is deleted.

Technical Master Data
Indicates if the technical data such as parameters, menus, groups, account authorizations, and so on,
is imported.
Note: This value is defaulted based on the setting in the Export Site Data form and cannot be modified.

Factory Track Application Master Data
Indicates if the application master data such as employee types, shifts, and so on, is imported.
Note: This value is defaulted based on the setting in the Export Site Data form and cannot be modified.

ERP Application Master Data
Indicates if the ERP application data such as employees, departments, work centers, and so on, is
imported.
Note: This value is defaulted based on the setting in the Export Site Data form and cannot be modified.

Include Users
Indicates if the user data from ERP is imported.
Note: Note: This value is defaulted based on the setting in the Export Site Data form and cannot be
modified.

From Date
The Start Date on which the transactional data is exported from the Export Site Data form.
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To Date
The End Date on which the transactional data is exported from the Export Site Data form.

Employee
The From and To fields define the range of employee IDs. The data for this specified range of employees
is imported.

Factory Track Version
The version number of the Factory Track.

ERP Version
The version number of the ERP.

Export Date
The date and time when the XML data has been exported.

5 Click Import.

Handling Units
You can use handling units to simplify inventory management by tracking containers, such as boxes and
pallets, rather than individual items. When you assign a handling unit to a container, the contents of that
container are bound to the handling unit. Any transactions you perform involving the handling unit also
affects its contents. As an example, let’s consider the requirement to move a box containing six serialized
computers to another location. If you assign a handling unit to the box, you can simply scan the handling unit
barcode, and all six computers will be transferred to the new location in ERP LN. You do not need to open the
box and scan each computer.

When performing some transactions, you can scan a handling unit in the Handling Unit or Reference ID
fields instead of the scanning the item number and other stock point information.

Handling units can contain other handling units, allowing you to perform transactions with multiple containers.
These handling units are called parents, and the handling units that they contain are called children. Any
transactions you perform on a parent handling unit also affects its children.

Kanban Overview
Use transactions in the Warehouse Mobility Kanban menu to manage your Kanban system. You can use these
transactions to create, track, replenish, and cancel Kanbans in Infor LN.

Kanbans always have a status to indicate their current place in the replenishment cycle. They change status
in this sequence:

1 In Stock: items are available
2 Requested (optional): replenishment is required
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3 Approved: replenishment request is approved
4 On Order: production, purchase, or transfer replenishment order is created
5 Received: order is filled

Kanbans that are not in use have the Canceled status.

The replenishment cycle a Kanban follows is its Kanban Loop. You can configure Kanban Loops on the Kanban
Loop form in Infor LN.

When performing some transactions, you can scan a Kanban number in the Kanban field instead of scanning
the item number and other stock point information.

Label Printing Overview
Many transactions in Infor Factory Track support barcode label printing. You can print labels from Factory
Track Mongoose forms and mobile scanner transactions.

To view a list of transactions that support label printing, see Label Printing Transactions List on page 19.

See Setting Up Label Printing.

You can view and re-print labels in Factory Track using the Label Print Summary form.

See Using the Label Print Summary Form on page 15.

Configuring Label Printing Connections
Use the Label Interface form to establish connections with the label printing software. There is only one record
available on this form. This record contains connection information that allows Infor Factory Track to
communicate with the BarTender label printing software.

1 Open the Label Interface form.
2 Specify this information:

Interface Type
If you are running Factory Track in the cloud, select Database Only. If you are running Factory Track
locally, select File. The Interface Number must always be ‘BarTender’.

File Path
Specify where Factory Track should create the data files needed to generate barcode labels. The BarTender
label printing software converts this data into actual files.

Field Separator
Specify a field separator to use for data files. By default, this must be set to a Pipe (|).

Label Template Path
Specify the file path location of the label templates. If you are running Factory Track in the cloud, this
location must be on the same server as the Cloud Printing Utility.
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3 Click Save.

Using the Label Print Summary Form
Use the Label Print Summary form to view printed label records. You can also re-print labels on this form.

See Viewing Printed Label Records on page 15.

See Re-printing Labels on page 15.

Viewing Printed Label Records
1 Open the Label Print Summary form.
2 To define label search criteria, specify some or all of this information:

Transaction Name
Select the transaction for which the label was originally printed.

User ID
Specify the user ID of the person who originally printed the label.

Request ID
To search for a label by its request ID, specify a starting and ending request ID. A request ID is recorded
for each label that is printed.

Create Date
To search for a label by the date it was created, specify a starting and ending date.

3 Click the Search button. The label request IDs that match the search criteria specified above are listed
in the grid.

4 To view additional details for each label printed for a label request ID, right-click the request ID and select
Details. The Label Print Details form is displayed.

5 Optionally, to view additional fields printed on the label that have been added by your organization, click
the Label Extensions tab.

Re-printing Labels
1 Open the Label Print Summary form.
2 To define label search criteria, specify some or all of this information:

Transaction Name
Select the transaction for which the label was originally printed.
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User ID
Specify the user ID of the person who originally printed the label.

Request ID
To search for a label by its request ID, specify a starting and ending request ID. A request ID is recorded
for each label that is printed.

Create Date
To search for a label by the date it was created, specify a starting and ending date.

3 Click the Search button. The label request IDs that match the search criteria specified above are listed
in the grid.

4 Optionally, to re-print a label request ID, select it from the grid and click Reprint. All labels associated
with that label request ID are printed.

Reference IDs
You can use reference IDs to perform transactions more efficiently. Reference IDs are unique barcode labels
that identify a specific item and stock point combination. Instead of scanning each stock point characteristic,
such as the item number, location, and lot number, to perform a transaction, you can scan the reference ID,
which will automatically specify the stock point characteristics. Reference IDs are usually scanned at the
beginning of a transaction.

The Valid Reference IDs are:

• ‘serial number ~ item number’
• handling unit
• lot number

The composition of your reference IDs will depend upon how you track and organize inventory at your
organization.

Note: You can only use a lot number as a reference ID when lot numbers are unique across all items and
cannot be split.

Teams Overview
You can use teams to streamline employee activities. Team members can start or stop jobs for all members
of their team in a single transaction. When a labor transaction is performed using the team number, that
transaction is replicated for all members of the team. A supervisor can also perform activities on behalf of
the team that will affect all of its members. For example, a supervisor can start a job for the team. All members
of the team will then be assigned to the started job. Using teams reduces the number of transactions that
need to be performed, thereby reducing the potential for employee errors, such as forgetting to start a job.
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Note:  Attendance transactions cannot be performed for a team. Employees must clock in and out individually.

You can create and manage teams using the Time Track module.

To use teams:

1 On the Teams form, create teams.
2 On the Teams form, assign employees to teams.
3 Use the team number instead of the employee number when performing labor transactions, such as

starting or stopping jobs.

Factory Track Groups
These authorization groups are defined in Factory Track by default:

• FT-Supervisor: Factory Track Supervisor Group. This group is assigned to supervisors, who are responsible
for employees and/or work centers. Time approval is controlled by settings associated with the employee’s
work group. This group has access to all the forms assigned to generic and dedicated users, so that the
user has full access to all the forms that the respective subordinates can use.

• FT-Base: This group contains all the forms such as pop-ups and tiles which the user does not access
directly. All the FT users excluding the administrators must have authorization to this group for all the
ERPs.

• FT-Employee: This group is for the dedicated users in Factory Track, that are linked to an employee such
as a back office employee.

• FT-TeamLeader: Factory Track Team Leader Group. Team leaders manage teams using the Shop Floor
module. These groups are authorized to create teams by adding and removing team members. Team
leaders can perform transactions for the entire team.

• FT-Integration: FT Integration Process. This is used for various FT ERP integration processes to perform.
• FT-Console: Factory Track Console group is for the generic users of Factory Track, that are not linked to

an employee such as a shop floor terminal.
• FT-LNWMNonTT: Infor FactoryTrack Non Time Track Labor Transactions for LN. This group is used for

WM (scanner) Transactions in LN implementations. This grants access to the Labor recording functions
using the LN-based Time module. (This is not assigned, if Time Track is being implemented).

• FT-LNWMInventory: Infor Factory Track Inventory for LN. This group is used for WM (Scanner) Transactions
in LN implementations. This grants access to the Inventory transactions for the scanner.

• FT-LNWMProduction: Infor Factory Track Production for LN. This group is used for WM (Scanner)
Transactions in LN implementations. This grants access to the Production support transactions for the
scanner.

• FT-TTWMTrans: Infor Factory Track Time Track WM Transactions - CSI & LN. This group is used for WM
(Scanner) Transactions when Time Track module is implemented.

• Infor-SystemAdministrator: This group is used to add users to Factory Track through the Ming.le interface.
This group is used by Factory Track for managing the Factory Track application. This is intended for users
who usually maintain setup, reference, and system data, such as employee records, transaction
parameters, and ERP connection information. This group includes all the FT forms, irrespective of the
ERP or Module, so that an administrator can be assigned to this group for accessing any FT form.
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Assigning Actions to Function Keys
Use the Function Key Action Values form to assign actions to the function keys on the mobile scanner devices
at your site.

1 Open the Function Key Action Values form. The device type is displayed.
2 Specify a key value from your scanner and a key description for each of these actions:

• Go To Previous Page
• Go To Main Menu
• Go To Help: Currently, this action has no effect; this version of Infor Factory Track does not support

opening help files from a mobile scanner device
• Reprint
• Logout
• Submit Form
• Move Up In List
• Move Down In List
• Select Current From List
• Refresh List
• Run Popup Form: opens a list of options from which to select for the current field; this action is only

supported for certain fields
• Special Value1: if applicable, performs an action associated with customizations made to your site
• Special Value2: if applicable, performs an action associated with customizations made to your site
• Special Value3: if applicable, performs an action associated with customizations made to your site

3 To assign actions to the specified key values, click Set.

Factory Track License Modules
Available Factory Track license modules and the related accessible capabilities are listed here:

Table 1: Usage of Factory Track License Modules

DescriptionLicense Module Name

Contains license for all FT IDO's. This is a developers
license. This is used for any application developing
integrating into FT.

FactoryTrackAuto

Contains license for all standard Mongoose Forms
and common FT forms. This cover both configuration
folder (excluding development folder) and System
folders. This is useful for System administration
purposes.

FactoryTrackBase

Cloud license, contains license for all FT forms except
the Dev forms.

FactoryTrackCloud
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DescriptionLicense Module Name

Contains License for IDO forms and Transaction
Setup forms(development folder in Configuration
menu). Useful for developers from customer side to
develop new transactions in FT.

FactoryTrackDev

This license allows access to forms that are exclusive-
ly Warehouse Mobility forms.

FactoryTrackMetrics

This module is for ShopFloor Transactions for LN.FactoryTrackShopFloorELN

This license allows access to Shop Floor forms that
are used with Time Track.

FactoryTrackShopFloorTTTrans

This license allows access to Time Track sheet forms.FactoryTrackTimeEntry

This license allows access to forms that are exclusive-
ly Time Track forms for Infor LN.

FactoryTrackTimeTrackELN

This license allows access to forms that are exclusive-
ly Warehouse Mobility forms for Infor LN.

FactoryTrackWMELN

This license allows site access to inventory transac-
tions in LN.

FactoryTrackWMLNInv

This license allows site access to production trans-
actions in LN.

FactoryTrackWMLNProd

Label Printing Transactions List
The transactions that support barcode label printing are listed. Click a transaction to view which types of
labels are printed for that transaction.

• Allocate Release on page 20
• Approvals on page 20
• Consignment Receipt on page 20
• Create HU on page 20
• Crossdocking on page 20
• Customer Returns on page 20
• Kanban Create on page 20
• Kanban Reinstate on page 20
• Kanban Reset on page 21
• Link HU on page 21
• Packing by Order on page 21
• Packing by Shipment on page 21
• Picking on page 21
• Putaway on page 21
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• Receiving on page 21
• Repacking on page 21
• Report Operation on page 21
• Report Production on page 21
• Split HU on page 21
• Transfer on page 22
• Unplanned Material Issue on page 22

Allocate Release

• Outbound: This transaction is included in the Outbound Transactions sub-menu and can generate an
Outbound label to display the pick action.

Approvals

• Inbound: This transaction is included in the Inbound Transactions sub-menu and can generate an Inbound
label to display the approval action. If a Handling Unit is approved, a Handling Unit label can be printed.

Consignment Receipt

• Inbound: This transaction is included in the Inbound Transactions sub-menu and can generate an Inbound
label to display the consignment receipt.

Create HU

• Handling unit: This transaction is included in the Handling Unit Transactions sub-menu and can print a
Handling Unit label.

Crossdocking

• Outbound: This transaction name is included in the Outbound Transactions and can generate an Inbound
label to display the crossdocking action.

Customer Returns

• Inbound: This transaction is included in the Inbound Transactions sub-menu and can generate an Inbound
label to display the customer returns.

Kanban Create

• Kanban: This transaction name is included in the Kanban Transactions and can generate the kanban
label.

Kanban Reinstate

• Kanban: This transaction name is included in the Kanban Transactions and can generate the kanban
label.
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Kanban Reset

• Kanban: This transaction name is included in the Kanban Transactions and can generate the kanban
label.

Link HU

• Handling unit: This transaction name is included in the Handling unit Transactions.

Packing by Order

• Handling unit: This transaction name is included in the Handling unit Transactions.

Packing by Shipment

• Handling unit: This transaction name is included in the Handling unit Transactions.

Picking

• Outbound: This transaction name is included in the Outbound Transactions.

Putaway

• Inbound: This transaction name is included in the Outbound Transactions.

Receiving

• Outbound: This transaction name is included in the Outbound Transactions.

Repacking

• Handling unit:This transaction name is included in the Handling unit Transactions.

Report Operation

• Handling unit: As the items are processed, the transaction defaults the corresponding names in the label
print process.

• Production: This transaction name is included in the Production Transactions.

Report Production

• Production: This transaction name is included in the Production Transactions.

Split HU

• Handling unit: This transaction name is included in the Handling unit.
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Transfer

• Inbound: This transaction name is included in the Inbound Transactions.

Unplanned Material Issue

• Outbound: This transaction name is included in the Outbound Transactions.

Adding Additional Fields to Barcode Labels
Use the Label Print Extensions form to add additional information fields to barcode labels.

1 Open the Label Print Extensions.
2 Click New or select a blank line from the grid.
3 Specify this information:

Label Request ID
Select a request ID for the field you are adding.

Label Request Seq
Optionally, specify a default sequence order in which to print this label.

Label Request Sub Seq
Optionally, specify a default sub-sequence order in which to print this label.

Field Name
Specify a name for the field.

Field Value
Optionally, specify a default value for this field. Leave blank to require users to specify the value.

4 Click Save.
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Chapter 2: Overview Infor Warehouse Mobility for Infor LN

This document provides instructions for using Infor Warehouse Mobility for Infor LN module in Infor LN. The
module includes a General Parameters session and form groups for Kanban, Packing, and Hours Accounting.

General Parameters
Use the Warehouse Mobility - General Parameters session to specify general parameters for Warehouse
Mobility transactions performed on handheld scanners. The parameters you specify on this form override
those specified with the Warehouse Mobility Administration Tool, if there are conflicts.

Kanban
Use the Warehouse Mobility - Kanban form group to manage your Kanban system. You can specify parameters,
configure Kanbans, view Kanban information, and manage Kanban requests.

Handling Unit based Packing
Use the Warehouse Mobility, Handling Unit based Packing form to manage Warehouse Mobility packing
transactions. You can specify parameters, view packing, shipping information, and can also release and
confirm shipments.

Hours Accounting
Use the Warehouse Mobility - Hours Accounting form group to manage Warehouse Mobility hours accounting
transactions. You can specify parameters, configure worksets and teams, and view clocking histories.
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Chapter 3: General Parameters for Warehouse Mobility in
Infor LN

This chapter describes how to specify general parameters for Warehouse Mobility in Infor LN.

Specifying general Warehouse Mobility parameters
Use the Warehouse Mobility - General Parameters form to specify general parameters for Warehouse Mobility
transactions performed on handheld scanners. The parameters you specify on this form override those
specified with the Warehouse Mobility Administration Tool, if there are conflicts.

To specify general parameters for Warehouse Mobility:

1 Select Warehouse Mobility > Warehouse Mobility - General Parameters.
2 From the grid, select the top row that has the Actual Set description.
3 On the Receipt tab, specify this information:

Description
Specify a description for this parameter set. For example, Parameter Set defined on 2013-03-12 8:40.

Factory Track Implemented
Select if Factory Track functionality is implemented

Add lots in Receiving
Select to assign lot numbers to items after the items are received.

Receive in Inventory Unit
Select to receive all items in the standard unit of measure.

Each Receipt Final Receipt
Select to designate all receipts as final.

Default Receipt Series
Select the check box to use the default series for all the receipts processed by barcode scanners.

Receipt Series
The series number assigned to receipts in Infor LN is displayed.

4 On the Picking tab, specify this information:
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Pre-Defined Stage Location for Pick/Pack
Specify the default staging location for items when picked or packed.

Stage Run Number
Specify the default run number to be used when picking on the scanner.

Picked Zone
Specify the zone used to determine whether items have been picked. Whenever a pick is performed on
the scanner, the goods are transferred to a location in this zone

Allow Overpick for Production Raw Material Issue
Select to allow quantities greater than the issued quantity for production to be picked.

Production Overpick – Tolerance Percentage
This is the acceptable tolerance for overpick against production orders.

Production Overpick – Hard Stop on Quantity
When selected, this indicates whether overpick must result in a hard stop.

Allow Overpick for Transfer Issue
Select to allow quantities greater than the issued quantity for transfer to be picked.

Transfer Overpick – Tolerance Percentage
This is the acceptable tolerance for overpick against transfer orders.

Transfer Overpick – Hard Stop on Quantity
When selected, this indicates whether overpick must result in a hard stop.

5 On the Production tab, specify this information:

Allow Backflush
Select to automatically issue production based on bill of material specifications when an operation or
order is reported.

Report Order if last operation
Select to automatically report an order when the last operation is completed.

Accept Questions during Report Operation
When selected this indicate that all the questions triggered during the Report Operation process must
automatically be answered.

Accept Questions during Report Production
When seleced to indicate that all questions triggered during the Report Production process should be
automatically answered in the affirmative.

Production History
Select to track production by shift.

Track Over Issue Transfer
Select to track issued inventory quantities that are greater than the ordered quantities.
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Over Issue Number Group
This parameter is available if you select Track Over Issue Transfer. Specify the number group for over
issue transfer series.

Over Issue Number Series
This parameter is available if you select Track Over Issue Transfer. Specify the number prefix for over
issue transfers.

6 On the Transfer tab, specify this information:

Generate Warehouse Order for Intra Warehouse Transfers
Select to generate transfer orders for inventory transfers within a warehouse.

Use Default Transfer Order Type and Series
Select this option to use the default series for all the transfers processed by barcode scanners.

Transfer Order Type
This parameter is available if you do not select the option to use the default type and series. Specify the
type of transfer order to create for inventory transfers.

Transfer Series
The series number assigned to Transfers in Infor LN is displayed.

7 On the General tab, specify this information:

User Name for Profile Template
Specify the Infor LN user name.

Reference Identifier Implemented
Select to use Reference ID shortcuts.

Reference Identifier Search Priority
Specify the order in which to resolve Reference ID values. For example, you specify Serial Number for
Priority 1 and Handling Unit for Priority 2. A user then specifies a value in a Reference ID field. The system
will first search for a serial number that matches that value, then, if it fails to do so, it will search for a
matching Handling Unit.

Note: 
• When using Serial Number as a Reference ID, users should scan a barcode containing both the serial

number and item number in this format: Serial Number~Item Number.
• To use Lot Code as a Reference ID, the lot codes used in your organization must each be restricted

to one stock point. If single lot codes exist at multiple stock points, the Lot Code Reference ID has
no effect.

8 Click Save.
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Chapter 4: Kanban for Warehouse Mobility in Infor LN

This chapter describes how to use Warehouse Mobility - Kanban sessions.

Specifying Kanban parameters
Use this form to specify parameters for hours accounting transactions performed on handheld scanners. The
parameters you specify on this form overrides those specified with the Warehouse

Mobility Administration Tool, if there are conflicts.

To specify Kanban parameters:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Setup Data > Kanban Parameters.
2 From the grid, select the top row with the description Actual Set.
3 On the General tab, specify this information:

Allow Warehouse Requests
Select to allow replenishment requests from the warehouse Kanban locations.

Allow Production Requests
Select to allow replenishment requests from the production Kanban locations.

Use Pre-Defined Kanban IDs
Select to pre-generate Kanban numbers that will be assigned to items, locations, and loops. Clear to
automatically generate new Kanban numbers when needed.

Number Type for Kanban ID
Specify the number group for Kanban ID order series.

Number Series for Kanban ID
Specify the number prefix for Kanban IDs.

Number Type for Kanban Request
Specify the number group for the Kanban request order series.

Number Series for Kanban Request
Specify the number prefix for the Kanban requests.

Kanban Inventory Holding Location
Specify the default staging location for Kanbans before delivered to the Kanban location..
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Allow Auto-Consumption
Select to automatically adjust inventory when a Kanban is delivered.

Reason Code
Specify the reason code to use for inventory adjustments due to auto-consumption.

Order Type for Direct Receipt
Specify an order type for direct receipt orders.

4 On the Purchase tab, specify this information:

Purchase Orders?
Select to allow Kanbans to be replenished by purchase orders.

Allow Purchase Orders?
This parameter is available if you select Purchase Orders?. Select to allow users to create purchase
orders for Kanban requests.

Combine at PO Line?
This parameter is available if you select Purchase Orders?. Select to allow separate Kanban requests
for the same item to be combined on a single purchase order line, if the supplier is the same for each
request.

Allow Direct Receipt?
This parameter is available if you select Purchase Orders?. Select to automatically deliver the Kanban
to its stock location in Infor LN when a Kanban order is received.

Combine Lines for Supplier?
This parameter is available if you select Purchase Orders?. Select to allow Kanban requests for different
items to be combined on a single purchase order, if the supplier is the same for each request. The requests
will be included as separate lines on the order.

Allow Order Series at Item?
This parameter is available if you select Purchase Orders?. Select to allow order types to be changed
for individual items. Clear to require that all items use the same order type.

Number group for Purchase
This parameter is available if you select Purchase Orders?. The number group for purchase order series
is displayed.

Number Series
This parameter is available if you select Purchase Orders?. Specify the number prefix for Kanban purchase
orders.

Order Type
This parameter is available if you select Purchase Orders?. Specify the number group for Kanban
purchase order series.

Auto-Approval?
This parameter is available if you select Purchase Orders?. Select to automatically approve requests
for purchase orders. Clear to require manual approval for these requests.
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Over-Receipt to Final Kanban
This parameter is available if you select Purchase Orders?. Select to add extra received item quantities
to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to create a
single-use temporary Kanban for excess quantities received.

Ordering Warehouse
This parameter is available if you select Purchase Orders?. Optionally, specify the warehouse that will
receive all purchase orders.

PO Print Report Name
This parameter is available if you select Purchase Orders?. Specify the name for the PO Print Report.

5 On the Production tab, specify this information:

Production Orders?
Select to allow Kanbans to be replenished by production orders.

Allow Order Series at Item?
This parameter is available if you select Production Orders?. Select to allow order types to be changed
for individual items. Clear to require that all items use the same order type.

Over-Receipt to Final Kanban
This parameter is available if you select Production Orders?. Select to add extra received item quantities
to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to create a
single-use temporary Kanban for excess quantities received.

Combine Requests?
This parameter is available if you select Production Orders?. Select to allow multiple Kanban requests
to be filled by a single production order.

Auto-Approval?
This parameter is available if you select Production Orders?. Select to automatically approve requests
for production orders. Clear to require manual approval for these requests.

Release Orders?
This parameter is available if you select Production Orders?. Select to allow approved Kanban production
requests to be filled immediately. Clear to require that these orders be released before they can be filled.

Allow Direct Receipt
This parameter is available if you select Production Orders?. Select to require that Kanban production
requests be approved before they can be filled.

Number Group for Production
This parameter is available if you select Production Orders?. The number group for production order
series is displayed.

Number Series
This parameter is available if you select Production Orders?. Specify the number prefix for Kanban
production orders.

6 On the Replenishment tab, specify this information:
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Replenishment Orders?
Select to allow Kanbans to be replenished by replenishment orders.

Number Group for Replenishment
This parameter is available if you select Replenishment Orders?. The number group for replenishment
order series is displayed.

Number Series
This parameter is available if you select Replenishment Orders?. Specify the number prefix for Kanban
replenishment orders.

Default Order Type
This parameter is available if you select Replenishment Orders?. Specify the default order type for
replenishment orders.

Allow Order Series at Item?
This parameter is available if you select Replenishment Orders?. Select to allow order types to be
changed for individual items. Clear to require that all items use the same order type.

Auto-Approval?
This parameter is available if you select Replenishment Orders?. Select to automatically approve
requests for replenishment orders . Clear to require manual approval for these requests.

Combine Requests?
This parameter is available if you select Replenishment Orders?. Select to allow multiple Kanban
requests to be filled by a single replenishment order.

Over-Receipt to Final Kanban
This parameter is available if you select Replenishment Orders?. Select to add extra received item
quantities to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to
create a single-use temporary Kanban for excess quantities received.

7 On the Transfer tab, specify this information:

Transfer Orders?
Select to allow Kanbans to be replenished by transfer orders.

Number Group for Transfer Orders
This parameter is available if you select Transfer Orders?. The number group for transfer order series is
displayed.

Number Series
This parameter is available if you select Transfer Orders?. Specify the number prefix for Kanban transfer
orders.

Default Order Type
This parameter is available if you select Transfer Orders?. Specify the default order type for transfer
orders.

Allow Order Series at Item?
This parameter is available if you select Transfer Orders?. Select to allow order types to be changed for
individual items. Clear to require that all items use the same order type.
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Release Orders?
This parameter is available if you select Transfer Orders?. Select to allow approved Kanban production
requests to be filled immediately. Clear to require that these orders be released before they can be filled.

Auto-Approval?
This parameter is available if you select Transfer Orders?. Select to automatically approve requests for
transfer orders. Clear to require manual approval for these requests.

Over-Receipt to Final Kanban
This parameter is available if you select Transfer Orders?. Select to add extra received item quantities
to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to create a
single-use temporary Kanban for excess quantities received.

Auto-Generate Outbound?
This parameter is available if you select Transfer Orders?. Select to automatically generate an outbound
run for transfers to another warehouse.

Combine Requests?
This parameter is available if you select Transfer Orders?. Select to allow multiple Kanban requests to
be filled by a single transfer order.

8 Click Save.

Creating or updating a Kanban Item
To specify Kanban information for an item:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Setup Data > Kanban Item
Information.

2 To create a Kanban, click New. To modify a Kanban, select it.
3 On the General tab, specify this information:

Warehouse
Specify the warehouse. Optionally, leave blank to configure default Kanban information for this item
for all warehouses. You can override this default item information for a particular warehouse by using
this form to also configure item information for a specified warehouse. If you are modifying an existing
Kanban item, this field is for display only.

Item
Specify the item number. If you are modifying an existing Kanban item, this field is for display only.

Quantity per Kanban
Specify the quantity for each Kanban.

Container
Specify a description for the Kanban container. This description is for informational purposes only.
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Order Type
Specify the order type to use for replenishment requests.

Order Group
The number group for the specified order type series is displayed.

Order Series
Specify the number prefix for replenishment requests.

Queued Request Depth
Specify how many Kanban requests must be made before an order is created to replenish them.

4 On the Order Details tab, specify the needed information, as applicable to the specified replenishment
order type. Fields pertaining to other order types are unavailable.
For purchase order, specify this information:

Purchase Order Type
The type of purchase order.

Delivery Days
The time required to fill a Kanban request.

Supplier
The supplier from which to purchase.

For production order, specify this information:

Routing
The routing for production orders associated with this item.

Production Warehouse
The warehouse in which the items are produced.

For transfer order, specify this information:

Replenishment Warehouse
The warehouse from which items are replenished.

Replenishment Order Type
The type of replenishment order for this item.

5 On the Local Parameters tab, specify this information:

Use Local Parameters?
Select to specify custom parameters for this item. Clear to use the general parameters specified on the
Kanban Parameters form.

Combine Requests
This parameter is available if you select Use Local Parameters?. Select to allow multiple Kanban requests
to be filled by a single production order.

Auto-Approval?
This parameter is available if you select Use Local Parameters?. Select to automatically approve orders
for Kanban requests. Clear to require manual approval for these orders.
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Release Orders
This parameter is available if you select Use Local Parameters?. Select to allow approved Kanban
production requests to be filled immediately. Clear to require that these orders be released before they
can be filled.

Generate Outbound
This parameter is available if you select Use Local Parameters?. Select to automatically generate an
outbound run for transfers to another warehouse. This field is only available for transfer order types.

Direct Order Receipt
This parameter is available if you select Use Local Parameters?. Select to require that Kanban production
requests be approved before they can be filled.

Over-Receipt to Final Kanban
This parameter is available if you select Use Local Parameters?. Select to add extra received item
quantities to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to
create a single-use temporary Kanban for excess quantities received.

Auto-Consume?
This parameter is available if you select Use Local Parameters?. Select to automatically adjust inventory
when a Kanban is delivered.

Reason Code
This parameter is available if you select Auto-Consume?. Specify the reason code to use for inventory
adjustments due to auto-consumption.

6 Click Save. The specified information is applied.

Configuring Kanban locations
A Kanban location is the point of use for a Kanban from which it will be consumed. Regardless of the current
status of the Kanban, this location does not change.

To configure Kanban locations:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Setup Data > Kanban Locations.
2 To create a new Kanban location, click the New button, or, to modify an existing Kanban location, select

a Kanban location.
3 Specify or review this information:

Kanban Location
Specify the Kanban location. If you are modifying an existing Kanban, this field is for display only.

Description
Specify a description for the Kanban location.

Location Type
Specify the type of location.

Infor Factory Track LN User Guide | 33DRAFT
 

Kanban for Warehouse Mobility in Infor LN



Warehouse
Specify the warehouse.

Location
Specify the location. If the specified warehouse does not contain any locations, this field is unavailable.

4 Click Save. The Kanban location is configured.

Configuring Kanban loops
The replenishment cycle a Kanban follows is its Kanban Loop.

To configure Kanban loops:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Setup Data > Kanban Loops.
2 To create a new Kanban loop, click the New button, or, to modify an existing Kanban loop, select a Kanban

loop.
3 On the Form 1 tab, specify or review this information:

Kanban Location
Specify the Kanban location. If you are modifying an existing Kanban loop, this field is for display only.

Item
The item number that is previously created as a Kanban Item. If you are modifying an existing Kanban
loop, this field is for display only.

Container
The description for the Kanban container. This description is for informational purposes only.

Ordering Type
The order type to use for replenishment requests.

Numbering Group for Order
The number group for the specified order type series is displayed.

Order Series
The prefix for replenishment requests.

Queued Request Depth
The number of Kanban requests that are made prior to creating an order to replenish these.

Number of Kanbans
The number of Kanbans using this loop is displayed.

Number of Temporary Kanbans
The number of temporary Kanbans using this loop is displayed.

4 On the Order Details tab, specify the information that is required for the order type.
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• For purchase order, specify this information:

Order Type
The type of purchase order.

Delivery Days
The time required for a supplier to deliver the item.

Supplier
The supplier from which to purchase.

Buyer
The employee badge of the buyer.

Planner
The employee badge of the planner.

• For production order, specify this information:

Routing
The routing for production orders associated with this loop.

Production Warehouse
The warehouse in which the items are produced.

• For transfer order and replenishment order, specify this information:

Replenishment Warehouse
The warehouse from which items are replenished.

Order Type
The type of replenishment order for this Kanban loop.

5 On the Local Parameters tab, specify this information:

Use Local Parameters?
Select to specify custom parameters for this item. Clear to use the general parameters specified on the
Kanban Parameters form.

Auto-Approval
This parameter is available if you select Use Local Parameters?. Select to automatically approve orders
for Kanban requests. Clear to require manual approval for these orders.

Combine Requests
This parameter is available if you select Use Local Parameters?. Select to allow multiple Kanban requests
to be filled by a single production order.

Release Orders
This parameter is available if you select Use Local Parameters?. Select to allow approved Kanban
production requests to be filled immediately. Clear to require that these orders be released before they
can be filled.
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Generate Outbound
This parameter is available if you select Use Local Parameters?. Select to automatically generate an
outbound run for transfers to another warehouse. This field is only available for transfer order types.

Direct Receipt
This parameter is available if you select Use Local Parameters?. Select to require that Kanban production
requests be approved before they can be filled.

Auto-Consume?
This parameter is available if you select Use Local Parameters?. Select to automatically adjust inventory
when a Kanban is delivered.

Reason Code
This parameter is available if you select Auto-Consume?. Specify the reason code to use for inventory
adjustments due to auto-consumption.

Over-Receipt to Final Kanban
This parameter is available if you select Use Local Parameters?. Select to add extra received item
quantities to the Kanban, or, if more than one Kanban is received, to the last Kanban received. Clear to
create a single-use temporary Kanban for excess quantities received.

6 Click Save. The Kanban loop is configured.

Configuring supplier delivery days
To configure delivery days for Kanban suppliers:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Setup Data > Kanban Supplier
Details.

2 To configure a new Kanban supplier, click theNew button, or, to modify an existing Kanban supplier,
select a Kanban supplier.

3 In the Supplier field, select a supplier. If you are configuring an existing supplier, this field is for display
purposes only.

4 Select the days on which deliveries can be made.
5 Click Save. The Kanban supplier is configured.

Viewing Kanban details
To view Kanban details:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Inquiries > Kanbans.
2 Click the Find button.
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3 You can search for Kanbans using these criteria: Kanban ID, location, order type, status, or item. Specify
the information that is required for the criterion you are using.
• For Kanban ID, specify this information:

Sort By
Select Access by Kanban ID.

Kanban ID
Specify the Kanban ID.

• For location, specify this information:

Sort By
Select Access by Kanban Location/Item.

Kanban Location
Specify the Kanban Location.

Item
Optionally, to sort results by item number, specify an item number.

Kanban ID
Optionally, to sort results by Kanban ID, specify a Kanban ID.

• For order type, specify this information:

Sort By
Select Access by Order Type.

Order Type
Specify the order type.

Position
Optionally, to sort results by order position, specify the position of the Kanban.

Kanban ID
Optionally, to sort results by Kanban ID, specify a Kanban ID.

• For status, specify this information:

Sort By
Select Access by Status.

Status
Specify the status of the Kanban.

Kanban ID
Optionally, specify the Kanban ID.

• For item, specify this information:

Item
Specify the item number.
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Kanban Location
Optionally, to sort by location, specify a Kanban location.

Kanban ID
Optionally, specify the Kanban ID.

4 Click OK. The Kanbans matching the specified criteria are displayed.
5 Select a Kanban. The Kanban information is displayed.

Viewing Kanban request details
To view Kanban request details:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Inquiries > Kanban Requests.
2 Select a Kanban request. The Kanban request information is displayed.

Rejecting Kanban requests
To reject Kanban requests:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Processing > Reject Kanban
Requests.

2 Select a Kanban request and then select Specific > Reject.

Approving Kanban requests
To approve Kanban requests:

1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Processing > Approve Kanban
Requests.

2 Select a Kanban request and then select Specific > Approve.

Processing Kanban requests
To process Kanban requests:

Infor Factory Track LN User Guide | 38DRAFT
 

Kanban for Warehouse Mobility in Infor LN



1 Select Warehouse Mobility > Warehouse Mobility - Kanban > Kanban Processing > Process Kanban
Requests.

2 Select the types of orders to process.
3 Specify criteria to identify the requests to process. Only requests that match these criteria are processed.

Optionally, leave fields blank to exclude them from the query.
Specify this information:
• Run number
• Requesting warehouse
• Delivery warehouse
• Kanban location
• Request number
• Buyer
• Planner
• User
• Supplier
• Item From
• Item To

4 Click Process. All requests matching the search criteria are processed.
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Chapter 5: Handling Unit based Packing for Warehouse
Mobility in Infor LN

This chapter describes how to use Warehouse Mobility – Handling Unit based Packing forms.

Specifying handling unit based packing parameters
Use this form to specify parameters for handling unit based packing transactions performed on handheld
scanners. The parameters you specify on this form will override those specified with the Warehouse Mobility
Administration Tool, if there are conflicts.

To specify packing parameters:

1 Select Warehouse Mobility > Warehouse Mobility -Handling Unit based Packing > Packing Parameters.
2 From the grid, select the top row with the description Actual Set.
3 Specify this information:

Description
Specify a description for this parameter set. For example, Parameter Set defined on 2013-03-12 8:40.

Handling Unit Based Packing Implemented
Select this to implement Handling Unit based Packing.

Box Default Packaging Item
Specify the Packaging Item to be used as a default when required.

Split Shipment Lines by Handling Unit
Select if Shipment Lines must be split by Handling Unit. If cleared, the original shipment lines must be
unchanged when multiple Handling Units are packed.

Allow Loads to be Split during Loading
Select this option to split a Load, if the original load is more and part of the load needs to be assigned
at other location.

Allow Shipment Confirmation after Loading
Select this option if the scanner must automatically proceed to the Shipment Confirmation transaction
after the loading process is completed.
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Assign Dock Numbers to Loads
Select this option if the loads are pre-assigned dock numbers. This field can be blank if the dock numbers
are assigned as the loading process takes place.

4 Click Save. The parameter set is applied.

Pre-Assigning Dock Numbers
Use this session to pre-assign dock numbers to loads if the option was selected in the parameters:

1 Select Warehouse Mobility > Warehouse Mobility – Handling Unit based Packing > Pre-Assign Dock
Numbers.

2 Specify this information:

Load
Specify the load.

Dock
Specify the dock number. This is not a validated field.

3 Click Save. The specified pre-assignment is saved.

Viewing Package Information
To view information about a package:

1 Select Warehouse Mobility > Warehouse Mobility – Handling Unit Based Packing > Handling Unit
based Packing - Packages.

2 From the grid, select a Handling Unit.
3 The Handling Unit information that is displayed includes this information:

Sealed
The package sealed status, the time and the person responsible for the task.

Loaded
The package loading status, the time and the person responsible for the task.

Shipped
The package shipped status, the time and the person responsible for the task.

Dock
The dock location to load the package.

Order Details
The Order Number of the Package.

Infor Factory Track LN User Guide | 41DRAFT
 

Handling Unit based Packing for Warehouse Mobility in Infor LN



Viewing packing details for an order
To view packing details for an order:

1 Select Warehouse Mobility > Warehouse Mobility – Handling Unit based Packing > Packing
Information.

2 Click Find button.
3 Specify this information:

Sort By
Select Order Details.

Order Origin
Specify the order type.

Order Number
Specify the order number.

4 Press Enter. The information displayed for each package on the order includes:

Pack Unit
The item unit of measure is displayed.

Pack Quantity
The quantity of packed items is displayed.

Infor Factory Track LN User Guide | 42DRAFT
 

Handling Unit based Packing for Warehouse Mobility in Infor LN



Chapter 6: Hours Accounting for Warehouse Mobility in
Infor LN

This chapter describes how to use Warehouse Mobility - Hours Accounting forms.

Specifying hours accounting parameters
Use this form to specify parameters for hours accounting transactions performed on handheld scanners. The
parameters you specify on this form will override those specified with the Warehouse Mobility Administration
Tool, if there are conflicts.

To specify hours accounting parameters:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > HRA Parameters.
2 From the grid, select the top row with the description Actual Set.
3 Specify this information:

Description
Specify a description for this parameter set. For example, Parameter Set defined on 2013-03-12 8:40.

Workset Implemented
Select to use worksets. Using worksets allows employee tasks to be grouped together in Infor LN to
simplify hours accounting activities.

Enable Workset by employee
This parameter is available if you select Workset Implemented. Select to designate certain employees
to use worksets. If you clear this check box, all employees will use worksets.

Dynamic Workset Handling
This parameter is available if you select Workset Implemented. Select to allow additional tasks to be
added to a workset in progress. If you clear this check box, all workset tasks must start and stop
simultaneously.

Default Time Split Handling
This parameter is available if you select Workset Implemented. To determine how time will be split
between multiple tasks within a workset, specify one of these:
• Simple Average: Divided equally between tasks.
• Weighted Average: Divided to each task based on its standard duration
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For example, if job A usually takes 20 minutes to complete and job B usually takes 40 minutes to
complete, twice as much time will be allocated to job B as to job A.

• Quantity Based: Divided to each task based on the quantity produced
For example, if task A produces two items and task B produces four items, twice as much time will
be allocated to job B as to job A.

Allow Time Split Method Modification
This parameter is available if you select Workset Implemented. Select to allow users to change the time
split method.

Quantity Based Split - Ignore Zero Quantity Jobs
This parameter is available if you select Workset Implemented. Select to ignore jobs with no quantity
when splitting time based on quantity. Clear to allocate a minimum amount of time to jobs with no
quantity when splitting time based on quantity.

Teams Implemented
Select to use Teams. Using teams allows employees to start and stop activities for their whole team. For
example, if employee A, B, and C are on a team, employee A can start an activity for the team, and that
start activity record is replicated for all three employees.

Apply Clock In/Clock Out Rules
Select to require employees to clock in to start activities. When selected, the start time of an activity can
be adjusted to match the clock-in time, depending on the shift type configuration. Clear to track hours
using activity start and stop times. When cleared, employees will not clock in.

Reference Working Time Schedule
This parameter is available if you select Apply Clock In/Clock Out Rules. Specify the default shift type
for labor time applied as costs to jobs.

Include Out-of-Shift Hours
This parameter is available if you select Apply Clock In/Clock Out Rules. Select to include hours worked
outside of shift hours.

4 Click Save. The parameter set is applied.

Viewing clock shift codes
To view clock shift codes:

Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Clock Shift Codes.
The information displayed for each clock shift code includes:

Rounding Period
The time interval to which clocked time is rounded is displayed. For example, the value 1.00 h rounds the
clocked time to the nearest hour.
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Maximum Elapsed Time Allowed
The maximum amount of time allowed between clock ins before a clock in counts for the following day is
displayed.

Specifying employee information
Use the Employees - People form (bpmdm0101m000) in the Infor LN to specify employee information.

Specifying working schedules for teams
To specify a working schedule for a team:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Teams.
2 From the grid, select a team.
3 Specify this information:

Team
The team badge is for display only on this form. Specify a description for team.

Active
This check box shows whether the team is active. This check box is for display only on this form.

Workset Allowed
Select to allow the team to use worksets.

Working Time Schedule
Optionally, specify a shift type. If specified, this value will override the shift type the team uses to clock
in.

Current Job Type
The type of job on which the team is working is displayed.

Current Job Number
The number of the job on which the team is working is displayed.

4 Optionally, to view the employees on a team, select the team, then select Specific > Team Members.
The team information is displayed.

5 Optionally, to view the history of a team, select the team, then select Specific > Team History. The team
history is displayed.
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Viewing employees on a team
To view the employees on a team:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Employees by Team
2 Click Find button.
3 Specify a team or employee badge and click OK. The employee information is displayed.

Viewing workset details
To view workset details:

1 Select Warehouse Mobility > > Warehouse Mobility - Hours Accounting > Workset Details.
2 The information for each workset is displayed.
3 Optionally, specify this information:

Time Split Method
To determine how time will be split between multiple tasks within a workset, specify one of these:
• Simple Average: Divided equally between tasks.
• Weighted Average: Divided to each task based on its standard duration For example, if job A usually

takes 20 minutes to complete and job B usually takes 40 minutes to complete, twice as much time
will be allocated to job B as to job A.

• Quantity Based: Divided to each task based on the quantity produced For example, if task A produces
two items and task B produces four items, twice as much time are allocated to job B as to job A.

Allow Time Split Method Modification
Select to allow users to change the time split method.

Viewing the jobs history of an employee, team, or workset
To view the jobs history associated with an employee, team, or workset:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Jobs by Workset.
2 Click Find button.
3 Select Badge, Type, Workset Seq.
4 Specify this information:

Badge
Specify an employee, team, or workset badge number.

Type
Specify the job type.
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Workset Seq
Optionally, specify a workset sequence.

5 Click OK. The information for each job record is displayed.

Viewing the history of a team
To view the history of a team:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Team History.
2 Click Find button.
3 Specify this information:

Team
Specify the team badge number.

Employee
Optionally, specify the employee badge number.

Sequence Number
Optionally, specify the sequence number.

4 Click OK. The team history information is displayed.

View the last clock in of an employee
To view the last clock in of an employee:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Employee Clock-In Data.
2 Select Employee and specify the employee badge number.
3 Click OK. The information for each employee is displayed.

Clocking out an employee or shift
To clock out an employee or shift:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Employee Auto Clock Out.
2 Specify a clock shift or employee to clock out in the From and To fields. Optionally, specify a different

value in the two fields to clock out both specified values and all the values between them.
3 Click Continue. The specified shifts or employees are clocked out.
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Configuring Tasks
1 Open the Tasks form.
2 Specify this information:

Task Code
Specify a task code to define how the hours performing the underlying task will be identified in Factory
Track. This is a required field.

Description
Specify a description of the activity represented by the task code.

Post to ERP
Select to post the time spent performing the task to the underlying ERP.

ERP Task Code
Specify the code to which the hours spent on the task are posted in the ERP. This must be a valid and
active code in the underlying ERP for hours related to this task to post successfully. If the Post to ERP
option is cleared, this field is unavailable.

Paid
Select to categorize the hours associated with this task as paid in payroll. If you clear this option, hours
associated with this task will categorize as unpaid. This option is selected by default.

Active
Select to activate this task, allowing users to book hours to it. If you clear this option, users will receive
a hard stop if they attempt to book time to this task.

General Task
Select to designate this task as a general task instead of an indirect task. General tasks are linked to an
order or project. Hours that are reported for a general task will be reported to the order or project linked
to that task rather than under the task code. General tasks can only be performed by employees who
are configured to use elapsed time.

3 If you selected the General Task check box, specify this information in the General Task section to link
an order or project to the task:
Note: The General Task section and related fields are only displayed if the General Task check box is
selected.

Facility
Specify a facility.

Order Type
Specify an order type.

Order Number or Project Number
Specify an order number or project number, depending upon the selected order type.

Suffix
This field is only displayed if the order type is Production Order, Service Order, or Setup. Specify an order
suffix.
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Operation
This field is only displayed if the order type is Production Order, Service Order, or Setup. Specify an
operation.

Task Code
If applicable, the task code is displayed.

Work Center
If applicable, the work center is displayed.

Item
If applicable, the item is displayed.

Machine
If applicable, the machine is displayed.

4 Click Save.

Viewing the clock in history of an employee
To view the clock in history of an employee:

1 Select Warehouse Mobility > Warehouse Mobility - Hours Accounting > Clock-In History.
2 Specify this information:

Employee
Specify an employee badge.

Date
Specify a clock in date.

Sequence Number
Optionally, specify a sequence number.

3 Click OK. The clock in history information for the employee is displayed.

Creating Badges
To create employee badges, use the Badges form.

1 Open the Badges form.
2 Select the last row from the grid at left.
3 Specify the badge number.
4 Select Active.
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5 Specify a valid employee number.

Modifying Badges
To modify existing badges, use the Badges form.

1 Open the Badges form.
2 Select the badge from the grid at left.
3 To assign an employee to the badge, specify a valid employee number.
4 To activate the badge, select Active. To deactivate the badge, clear this check box.
5 Click Save.
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Chapter 7: Parameters Overview

Use the Infor Factory Track parameters forms to customize the application to meet the specific needs of your
organization. There are two types of parameters forms:

• Parameter definitions forms: These forms are only used by programmers who are authorized to customize
your application. They define what transaction parameter settings are available.

• Parameter settings forms: You can use these forms to configure the behavior of the application and its
individual transactions.

Parameter Definitions Forms

Caution:  Only programmers who are authorized to customize your application should use the parameter
setup forms. Changes made to these forms can cause your application to function incorrectly.

The parameter setup forms are used to define what transactions and parameters are available to administrators
using the parameter settings forms. The Global Parameters Setup form is used to define the parameters to
be displayed and specified on the Global Parameters form, which affect all Infor Factory Track transactions
and forms.

The Transactions Setup form is used to determine what transactions are available in the application and to
define the parameters used by each transaction. This form can be used to add custom transactions to your
parameter management system.

The User Parameters form is used to define parameters at the user level. These parameters are displayed and
configured on the User Extensions form.

Parameter Settings Forms

Use the parameter settings forms to configure the behavior of the application and its individual transactions.
These parameter settings forms are available for the application:

• Global Parameters: You can use this form to configure parameters that apply to all Infor Factory Track
transactions and forms.

• Transaction Set Maintenance: Use this form to configure parameters for individual transactions. You can
also designate which order types are enabled for each transaction and which will use order-specific
parameter values.

• Transaction Warehouse Order Type Print Parameters: Use this form to configure label printing settings
for specific transactions at the transaction, order type, or warehouse level.

• User Extensions: Use this form to configure settings for individual users.
• Warehouse Parameters: Use this form to configure transaction parameters that are specific to a warehouse.
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• Shop Floor Parameters: Use this form to configure transaction parameters that are specific to shopfloor.
• Parameter Groups Settings: Use this form view the parameters that are applicable to the Infor FactoryTrack

transactions and forms.

Configuring an Employee (Named User or Kiosk User)
A cross-reference between the employee and their user profile is established on the Employees form to allow
an employee to access Factory Track using their own profile. This allows the employee to log into Factory
Track and perform transactions based on the Factory Track role specified in their user profile. Employees
that are not configured as “Named Users” (Kiosk Users) access Factory Track through Console User Profiles.

To establish an employee record – user profile cross-reference:

1 Open the Employees form.
2 Select the employee for whom employee-user access is given.
3 In the User Name field, select the user that will be cross-referenced to the selected employee.
4 Specify this information in the Kiosk section of the Employee form:

Attendance
If this check box is selected, the employee can clock in using Factory Track transaction forms.

Labor
If this check box is selected, the employee can enter labor records using Factory Track transaction forms.

Absence Request
If this check box is selected, the employee can submit absence requests using Factory Track request
forms.

Edit Labor
If this check box is selected, user can edit the labor records or insert the gap records. The user must be
assigned the required edit privileges in the Employee form.

Edit Absences
If this check box is selected, the employee can change the status of an absence request from Requested
to Denied. Based on the status update the request is cancelled.
Note: 
• If the status is set to Approved, the employee cannot modify the status to Denied.
• Employees cannot edit or delete attendance transactions.

5 Save the employee record.
6 Open the FT Users Maint form.
7 Select the user that is specified in step 3.
8 Confirm that the employee ID and name now displayed in the Employee fields.
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Configuring Barcodes
You can define how barcodes work in your application by modifying the existing barcode prefixes, combination
barcodes, and cross reference values.

Setting up barcode prefixes

You can use the Prefix Handling form to set up barcode prefixes. Barcode prefixes are embedded at the
beginning of barcodes and are used to indicate the barcode type. You can set mandatory prefixes to control
which barcode types can be scanned into certain field types. Using mandatory prefixes can help prevent users
from scanning the wrong barcode into a field.

See Setting Up Barcode Prefixes on page 53.

Setting up combination barcodes

Combination barcodes can increase the efficiency of your scanner operations by combining multiple barcodes
into a single barcode string. Use the Multi-Barcode Split form to set up combination barcodes. You can define
which transactions will use combination barcodes and define the properties of those combination barcodes.

See Setting Up Combination Barcodes on page 54.

Setting Up Barcode Prefixes
Use the Prefix Handling form to set up barcode prefixes. Barcode prefixes are embedded at the beginning of
barcodes and are used to indicate the barcode type. You can set mandatory prefixes to control which barcode
types can be scanned into certain field types. Using mandatory prefixes can help prevent users from scanning
the wrong barcode into a field.

1 Open the Prefix Handling form.
2 To set up a new barcode prefix field type, click New or select a blank line from the grid at the left. To

modify an existing barcode prefix field type, select it from the grid.
3 Specify or review this information:

Prefix Field Type
Specify a name for the field type. If you are modifying an existing barcode prefix field type, this field is
read only.

Prefix Mandatory
Select this check box to prevent barcodes that do not contain the prefix from being scanned into this
field type.

4 In the Data Prefix Details grid, define prefix values for this prefix field type. To define a prefix value, select
a blank or existing line in the grid and specify this information:

Prefix Seq
Specify the sequence in which to search for this prefix. For example, specify 1 to search for this prefix
first when a barcode is scanned in this field type.
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Prefix Code
Specify a character value for the prefix.

5 Click Save.

Setting Up Combination Barcodes
Combined barcodes increases the efficiency of the scanner operations by combining multiple barcodes into
a single barcode string. Factory Track is setup to split this single barcode string to the respective fields in each
transaction.

The Multi-Barcode Split form is used to setup Factory Track transaction to split combined barcodes. It allows
you to specify transactions using combined barcodes and separator and fields used by the combined barcodes.

Note: The Multi-Barcode Split form only allows you to setup barcode splitting for the transaction in the current
ERP.

1 To Setup a New Combined Barcode for a Transaction
a Open the Multi-Barcode Split form.
b Click New or select a blank line in the grid on the left to setup new transaction.
c Specify this information:

Transaction Name
The name of the transaction to set up the combined barcode.

Source Field
The name of the source field for the new combined barcode.
Note: This field displays the list of fields used by the combined barcodes. You can scan the combined
barcode in the initial field specified in the source field. The transaction then splits the scanned
barcode.

Fixed Length
The fixed character length to define different information types within the combination barcode.
Clear to use a separator character to define different information types within the combination
barcode.
Note: If you select this check box:
• The Field Length field is displayed. The field length defines the segment length for the Target

Field.
• You cannot specify the value in Mapping Separator field.

Mapping Separator
Each segment of the combined barcode is of fixed length.

d Click New Record in the grid or the New Record in the toolbar to add a target field.
e Add the Group Sequence number for the selected target field.
f Select the required Target Field. This field lists the values as displayed on the Fields tab of the

Transactions Setup form. When the user selects a field the internal field name is stored in the multi
barcode table.
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g Click Save.

2 To modify an existing combined barcode for a transaction
a Select the transaction in the left-hand grid.
b Click required field(s) to modify.
c Change the selected field as per the descriptions in the “combined barcode” section.

Configuring Employee Records - Time Track implemented
To configure employee records, use the Employees form. If you wish to grant kiosk access to an employee,
you must create a Mongoose security profile for the employee on the Users form.

1 Open the Employees form.
2 In the Employees form, select a blank line or an existing employee record from the grid at left.
3 Specify the employee number, employee name, and job title.
4 On the General tab, specify the employee's last name, first name, and middle initial.
5 Specify this additional information:

Badge ID
The badge number. The default value is the employee number.

Payroll ID
The payroll ID value. This is required only if your payroll application requires a unique ID other than the
employee number.

Active
Select to activate the employee record. Employee records must be active for them to appear in the Hours
Summary and Hours Detail forms, and to perform transactions against the employee record. Deselect
Active to prevent display of the employee's records and the execution of transactions for this employee.
For example, consider an employee who has been terminated. As long as the employee record is active,
all report dates prior to the termination date will be displayed and transactions may be performed or
edited for those dates. If the record is deactivated, none of the employee's records will display and no
further transaction entry or editing will be allowed.

PIN
Specify a PIN number. This number is used to sign into the application as a generic user when Time Track
is not implemented. This field is only available if the PIN Required parameter is selected on the Global
Parameters form.

User Initials
This field is set to a pre-established value, which indicates that the transaction originates in Factory
Track. The value can be modified to display the employee’s initials (three characters).

Facility
This field is only displayed in Time Track mode. Specify the facility where this employee works.
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Department
The department code. This field is only displayed in Shop Floor and Time Track mode.

Work Group
The work group. This field is displayed in Time Track mode and shop floor.  An employee's work group
defines the supervisor.

Emp Type
The employee type. This field is only displayed in Time Track mode.

Shift
The shift during which the employee usually work. An employee's shift defines the clock-in and clock-out
rules. This field is displayed as Schedule ID if Shop Floor in use.

Shift Pattern
This field is only displayed in Time Track mode. If appropriate, specify a shift pattern from the list.

Indirect Task
This field is only displayed in Time Track mode. Optionally, specify an indirect task from the list. This
will be the default task used for filling clocking gaps.

ERP Cost Component
Optionally, specify an appropriate value. This value is required if your company has a defined cost
structure. This value will be included when transactions post to ERP.

Workset Enabled
Select this check box to validate that an employee is eligible to work in worksets. Worksets allow
employees to work on multiple jobs at the same time.
Note: 
• Workset-enabled employees are unable to start just-in-time production orders or production

schedules.
• When the employee has any open job, the check box cannot be modified. 'The employee has open

job(s) cannot change workset.' message is displayed

6 In the Kiosk Access section, specify this information:

User Name
Specify a username for this employee. The employee must have a Mongoose security profile in order to
establish kiosk access.  The value entered in this field must be a valid Mongoose profile username.

Attendance
Select this checkbox to enable this employee to clock in and out from the kiosk only in Time Track mode.

Labor
Select this check box to enable this employee to start a job from the kiosk only in Time Track mode.

Absences Requests
Allow this employee to request absence time from the kiosk only in Time Track mode.

Edit Labor
Select this check box to allow this employee to edit and delete their own labor records or create gap
records only in Time Track mode.
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Edit Absences
Select this check box to allow this employee to withdraw absence requests only in Time Track mode.

Report/Move Quantity
Select this check box to allow this employee to report quantities and move quantities when using Time
Track Labor entry forms.

Move To Inventory
Select this check box to allow this employee to move quantities to inventory on the last operation when
using Time Track Labor entry forms.
Note: This parameter is not applicable for Factory Track integration with LN.

Default Order Type
An order type that must default into the Order Type field on any transaction entry form that the employee’s
employee number has been entered into.

Default Resource Group
The default resource group used by FT for the employee in all editable resource group fields

Default Resource
The default resource used by FT for the employee in all editable resource fields.

7 On the Contact Information tab, specify this information:

Hire Date
Specify the date the employee was hired, or click the arrow to select a date from the calendar. For active
employee records, all report dates equal to or more recent than the hire date will display in the Hours
Summary and Hours Detail forms. These dates will accept transactions for the employee. Dates prior to
the hire date will not display or accept transactions.

Termination Date
If appropriate, specify a date of termination, or click the arrow to select a date from the calendar. For
active employee records, all report dates prior to the termination date will display in the Hours Summary
and Hours Detail forms and will accept transactions for the employee. Dates equal to or more recent
than the termination date will not display or accept transactions.

E-mail Address
Optionally, if this employee will receive email notifications of absence request approvals or denials,
specify an email address.

Note: Personal Identification fields are not required for most Factory Track features. The only exception
is E-mail address for Console User-Employees.

8 On the Absences tab, if you are using absence tracking, specify the time off group ID and tracking year.
The Absences tab is only displayed in Time Track mode.

Tracking year
Displays the tracking group for the available years.
To configure an employee's absence tracking:

a Click New.
b Specify Tracking Year, Time Off Group Id and Effective Date.
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c Click Save.

Creating and Modifying Global Parameters
Use the Global Parameters Setup form to create and modify parameter options that will affect all Infor Factory
Track transactions. Administrators can configure these parameters on the Global Parameters form to customize
the application.

Caution:  Only programmers who are authorized to customize your application should use the Global
Parameters form. Changes made to this form can cause your application to function incorrectly.

1 Open the Global Parameters form.
2 If you are creating a new parameter, click New or select a blank line on the grid. If you are modifying an

existing parameter, select it from the grid.
3 Specify or review this information:

ERP Type
Select the ERP to which this parameter applies. If you are modifying an existing parameter, this field is
unavailable.

Global Param Name
The name for the parameter. If you are modifying an existing parameter, this field is unavailable. This
is applicable for all the modules such as Shop Floor, Warehouse Mobility, and Time Track.

Global Param Type
Select a parameter type: String, Boolean, or Numeric.

Global Param Value
Optionally, specify a default value for this field. Leave blank to require users to specify the value.

Description
Specify a description for the parameter.

End User Description
Optionally, specify a description to use for end users.

Parameter Parent
Optionally, specify a parent parameter. A parameter is only visible if its parent parameter is enabled.

Parameter Sequence
Optionally, specify a sequence number to determine where this parameter should be displayed in the
parameter list. If you do not specify sequence numbers for parameters, they are displayed alphabetically.

4 Click Save.
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Configuring Global Parameters
Use the Global Parameters form to configure parameters that apply to all Infor Factory Track transactions
and forms.

To configure Global Parameters:

1 Open the Global Parameters form.
2 Specify this information:

Kanban implemented
Select this check box to specify whether Kanban is implemented in this configuration. If this checkbox
is not selected, the Kanban processes are not supported in Factory Track.

Kanban Label
Specify a label ID for Kanban labels. This field is only displayed if the Kanban implemented parameter
is selected.

Handling units in use
Select this check box to use handling units.

ERP Lot is Supplier Lot
Select this check box to automatically use the supplier lot number as the ERP Lot Number.

EAN code in use
Select this check box to enable the users to scan European Article Numbers instead of the item numbers.
When you scan a European Article Number, the corresponding item number is displayed on the scanner,
if a match is found.

ICS code in use
Select this check box to enable the users to scan Item Code System numbers instead of the item numbers.
When users scan an Item Code System number, the corresponding item number will be displayed on
the scanner, if a match is found.

Module
The Module (WM, TT, SF or All) which this parameter belongs to.

Shop Floor in Use
Select this check box to allow users to access the shop floor module in Factory Track.

TT is implemented
Select this check box to allow users to access the time track related transactions in factory track.

None
Select this checkbox if both Shop Floor and Time Track are not implemented.

PIN Required
Select this check box to make PIN number mandatory when employees sign in as a generic user.

3 Click Save.
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Configuring Shop Floor Parameters
Use the Shop Floor Parameters form to configure parameters that are applicable to all the Infor Factory Track
Shop Floor transactions and forms.

To configure Shop Floor Parameters:

1 Open the Shop Floor Parameters form.
2 Specify this information:

ERP Available
Select this checkbox to access the available ERP type. You can also access the Task Details-Materials
form.

Maximum number of Tasks to Display
The maximum number of allowed tasks provided in the field must be displayed in the Dispatch List,
Assignment List and Resource Assignment of the Resource forms.

Allow Multiple Tasks by Operator
Select this checkbox to allow the operator on working for multiple tasks at the same time.

Allow Multiple Tasks by Machine
Select this checkbox to allow the multiple on working for multiple tasks at the same time.
Note: This functionality is not allowed for machines that have machine integration functionality selected.
These machines are only permitted to work on one task at a given point of time.

Gap Interval (in Minutes)
The gap interval expressed in minutes applied to the process of starting and stopping multiple tasks for
the same operator or machine.

Show Unassigned Tasks
Select this checkbox to display only unassigned tasks in addition to any assigned tasks.

Supervisor Start Page
The home page for the supervisor is displayed, after successful login. Select the Resource Summary or
Assignment List to determine the starting page for a supervisor login.

Resource Summary
The Resource Summary page is displayed, after successful login.

Assignment List
The Assignment List page is displayed, after successful login.

Display Welcome Message
Select this checkbox to display welcome message to the supervisor.

Biometric System in Use
Select this checkbox to use the biometric functionality by the user. If this checkbox is selected, these
biometric options are displayed:
• Biometric Instruction: Enter the instructions for the employee to follow if the Biometric System in

use is selected. By default, the application displays this instruction message, Please scan your
right index finger.
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• Biometric Message Validity (in seconds): Select this to display the valid biometric message for the
user. By default, the application displays 30 seconds that the application needs to wait for a successful
biometric scan.

3 Click Save.

Configuring Printers
Use the Label Printer Configuration form to configure printers.

1 Open the Label Printer Configuration form.
2 To create a new printer, click New. To configure an existing printer, select it from the grid.
3 Specify or review this information:

Printer Name
Specify a name for the printer. If you are configuring an existing printer, this field is read only.

Physical Location
Specify the physical location of the printer. For example, Receiving Dock.

Printer Path
Specify the network path for the printer.

Mobile Printer
Select this check box if the printer is mobile.

4 Click Save.

Configuring Site Parameters
To configure site parameters:

1 Open the Site Parameters form.
2 Specify this information:

Site
Specify the appropriate site. The site name and description are displayed. If you need to create a new
site, open the Sites form.

ERP Type
Select Infor LN as the ERP Type.

Default Menu Group
Determines which menus the users must view by default.

Infor Factory Track LN User Guide | 61DRAFT
 

Parameters Overview



Encoding
Specify which encoding type to use in XML file statements when connecting to the ERP.

3 To generate form component views, click Generate Strings View, Generate Component View, Generate
Menus View, and Generate Images View.

4 On the Calendar Setup tab, select a start date for the site calendar and specify a tracking year.
a Click Site Holidays to edit holidays.
b Click Site Calendar to view a 12 month array of the site calendar.
c Configure Work Week Start Day. Specify this information:

1st Day of Work Week
Set the day of the week that must be considered as the first day of the work week. By default, this
value is set to Monday.
Note: For Daily Elapsed Employees and Clocked hours employees, this day is considered as the start
day of the work week for the selection criteria on the Hours Summary and Daily Elapsed Summary
forms. This day is also considered for Weekly Elapsed employees' hours processing. Weekly Elapsed
employees must be assigned to Payroll Schedules that have period start dates that correspond with
the Site’s 1st Day of the Work Week setting.

Work Week Effective Date
Specify the date from which the change in the first day of the work week, is effective. All the weekly
selection criteria for report dates equal to and after this date use the corresponding 1st Day of Work
Week to display the records. Queries on report dates, prior to the Work Week Effective Date use the
1st Day of Work Week corresponding to the effective date, for the display of records. If there is no
Work Week Effective date that corresponds to the report dates in the query, the default 1st Day of
the Work Week is considered for the display of records.
Note: For Weekly Elapsed Employees in addition to use in selection queries, this parameter is
considered as the work week start date for the selection criteria on the Hours Summary and Weekly
Elapsed Summary forms

Generate work week
Click Generate work week to modify the 1st Day of Work Week setting. If a Work Week Effective Date
is specified, report dates prior to the effective date use the default 1st Day of Work Week or the 1st
day that corresponds to the 1st day defined for the period, prior to this change.
Note: 
• For Weekly Elapsed Employees, effective dates should be set to the current calendar date or to

a future date.
• Elapsed Detail records for weekly employees on report dates prior to the effective date of the

work week change or that have create dates that are prior to the work week change, create
date cannot be reset. The Generate Work Week utility resets records to the new Work Week
Start for Weekly Elapsed Time employees with Elapsed Detail records for future dates (ie,
planned absences or holiday abs records).

• Contact Infor Support to review your data structure prior to generating a new work week start
day.

5 On the LN Communication tab, specify this information:

Web Service URL
Specify the Web service URL for your company. You can find this URL on the Connector for Web Services
page. On the Connector for Web Services Page, click Web Services Status and open the first available
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WSDL file associated with your company. You can copy the WSDL URL from the WSDL file and paste it
into this field.

Web Service Suffix
Specify the Web service suffix that corresponds to your company. This suffix will be used for any Web
services that do not have a suffix defined on the Web Service Connectors form.

Seconds Before Timeout
The waiting time mentioned in seconds before Factory Track frontend session stops the integration
request sent to Infor LN.

Encoding
The programmed message string exchanged between Factory Track and Infor LN. The default value is
set to UTF-8.

Authentication Method
The field is used to select the authentication method to integrate Infor LN with Connector for Web
Services (C4WS). The customer can set the value to:
a. Regular: This is defaulted in the field.
b. Oauth1.0 authentication: If OAuth1.0a is selected, consumer key and secret key must be provided.
Based on the type of authentication method, the form displays different fields for integrating Factory
Track to a Multi-Tenant LN environment. This section explains the authentication process:
If this field is set to Regular, these optional fields are displayed:
1. Company Number
2. LN User
3. Password
Note: 
• By default, Authentication Method displays Regular.
• If the optional fields are specified, Infor LN uses the company number/username/password provided

in the Site Parameters form.
• If optional fields are not specified, Infor LN uses the values setup in the ERP Server pages of C4WS.
If this field is set to OAuth 1.0a, these fields are also displayed (apart from the optional fields):
1. Consumer key: The Consumer key as specified in the C4WS settings of the Advanced Settings Page is
provided here.
2. Secret Key: The Secret key from the C4WS settings of the Advanced Settings Page is provided here.

6 Select Record Queries in Tran History check box to store LN Database Query Inputs and Responses in
the Transaction History table. This check box supports the Query Logging feature. Based on this field,
the queries that are run as part of FT processes can be utilized by the support team to know the update
calls performed on LN. The Current Transaction Workbench form is updated to enable the operator to
view the captured queries and the related information from LN.

7 Click on the LN CommunicationTest Connection tab to verify the connection to the ERP server.
8 On the TestTime track tab, specify this information:

Payroll Code
Optionally, specify a payroll code. Payroll codes identify each record as originating from a particular
site.
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ERP Code
Specify an ERP code. Typically, a site code for Infor Factory Track is specified in the underlying ERP
software. The ERP code specified on the Site Parameters form must match the Infor Factory Track site
code specified in the ERP.

ERP Shift
Specify an ERP shift code. The code specifies a Working Time Table (WTT), which is a generic 24/7 calendar
specified in the ERP system.

Allow Offset Posting
Select this check box to automatically zero out frozen posts by posting an offsetting negative value; for
example, a frozen post of 4 hours will be offset by a post of -4 hours. Clear this check box to display an
ERP error in response to frozen posts.

Allow Repost
Select this check box to allow edited transactions to repost to the ERP system. Clear this check box to
display an ERP error in response to reposted transactions.

Use Global Posting
Select this check box to specify how to prevent posting of records sharing a specific employee number
and report date combination when one or more records contains an error. For example, an employee
posts a group of four records in which the third record contains an error. Select Use Global Posting to
block posting of all four records. Clear this check box to post records 1, 2, and 4, and to block only record
3.

Post Start End Times to ERP
Select this check box to report shift start and end times to ERP even when those times occur on separate
days. Clear this field to always report shift start and end times on the same day in accordance with the
configuration settings of the shift.

Allow Revert Processed Payroll
Select this checkbox to allow users to revert payroll from Processed to Submitted.
Note: 
• If the checkbox is selected and the user has the work group privilege Revert Payroll set to Yes, users

can use the revert icon on the Payroll Summary and Payroll Detail forms to revert payroll from
Processed to Submitted. When the user’s work group privilege Revert Payroll is set to No the revert
icon is set to active but if the user invokes it they will be hard stopped with a message advising the
user is not authorized to revert payroll.

• If the checkbox is cleared, the revert Icon for both the Payroll Summary and Payroll Detail forms is
deactivated. The feature is turned off for all users regardless of the Work Group privilege setting.

Allow Attendance Transactions On Future Date
If this check box is selected, future transaction dates and times can be used when entering attendance
or labor transactions. If the check box is cleared, only current or past transaction dates and times can
be used.
Note: The parameter does not restrict entry of planned absences or future absence requests.

9 On the Colors tab, click Colors to select a color format to denote holidays. Specify a foreground (text)
color and a background color and view the result in the Sample field. When finished, click Save and Exit.
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Creating and Modifying User Parameters
Use the User Parameters form to create and modify parameter options for specific users. Administrators can
configure these parameters on the User Extensions form to customize user permissions and settings.

Caution:  Only programmers who are authorized to customize your Infor Factory Track application should
use the User Parameters form. Changes made to this form can cause your application to function incorrectly.

1 Open the User Parameters form.
2 If you are creating a new parameter, click New or select a blank line on the grid. If you are modifying an

existing parameter, select it from the grid.
3 Specify or review this information:

ERP Type
Specify the ERP type to which this parameter applies. If you are modifying an existing parameter, this
field is unavailable.

Parameter Name
Specify a name for the parameter. If you are modifying an existing parameter, this field is unavailable.

Parameter Type
Select a parameter type: String, Boolean, or Numeric.

Parameter Value
Optionally, specify a default value for this field. Leave blank to require users to specify the value.

Description
Specify a description for the parameter.

End User Description
Optionally, specify a description to use for end users.

Parameter Parent
Optionally, specify a parent parameter. A parameter is only visible if its parent parameter is enabled.

Parameter Sequence
Optionally, specify a sequence number to determine where this parameter should be displayed in the
parameter list. If you do not specify sequence numbers for parameters, they are displayed alphabetically.

4 Click Save.

Configuring User Parameters
Use the Factory Track Tab on the users form to configure settings for individual users Factory Track
parameters.

Note: The User Extension Form is not used for this purpose in the FT application.
1 Open the User form.
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2 To configure parameters for an existing user, select a user ID from the grid. To configure parameters for
a new user, select a blank line from the grid and specify a user name in the User Name field.

3 Specify or review this information:

User Type
To define what permissions this user has, select a user type.

Employee
The employee name and ID associated with this user ID are displayed. You can link employee IDs to User
IDs on the Employees form.

Warehouse
Specify a default warehouse for this user. If the Trans Fill Whse parameter is selected on the Transaction
Set Maintenance form, this warehouse will be used by default instead of the default warehouse specified
for the transaction.

Label Printer
Specify a default printer for this user. If the Override User Printer parameter is cleared on the Transaction
Warehouse Order Type Print Parameters form, this printer will be used instead of the printer specified
for the transaction.

ERP Document Printer
Specify the default printer that must be used for to print ERP documents. For example, shipping
documents.
Note: User cannot verify the contents of this field, so the data(as defined by the ERP) must be entered
correctly in this field.

User Can Change Clock
Select this check box to allow the user to change the time and date recorded for the transactions they
perform.

Caution:  This parameter allows users to change the time record for transactions, including time and
attendance and job start and stop transactions. You should only select this parameter for managers
or similar personnel.

LN User
Use the LN username to integrate with Infor LN.

4 Configure these parameters:

Override Quantity Tolerance
Select this check box to allow the user to override the quantity tolerance set in your ERP system.

Override Date Tolerance
Select this check box to allow the user to override the date tolerance set in your ERP system.

Allow Change Warehouse
Select this check box to allow the user to specify a warehouse when running transactions. Clear this
check box to require the user to always use the default warehouse.

5 Click Save.
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Defining Label Formats
Use the Label Formats form to define label formats.

1 Open the Label Formats form.
2 To define a new label format, click New. To modify an existing label format, select it from the grid.
3 Specify this information:

Label Name
Specify a name for the label. This name must match the label format file name used in the Bartender
application.

Description
Optionally, specify a description for the label.

Label Size
Optionally, specify a size for the label.

4 Click Save.

Defining Data Domains
Use the Data Domains form to define data domains.

Caution:  Only programmers who are authorized to customize your application should use the Data Domains
form. Changes made to this form can cause your application to function incorrectly.

1 To modify an existing data domain, select it from the grid. To create a new data domain, select a blank
line from the grid.

2 Specify this information:

ERP Type
Select the ERP type.

Data Domain
Specify the name of the domain to which this entry applies.

Data Type
Select a data type:
• String

• Date

• Time

• Date-Time

• Boolean

• Integer

• Decimal
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Data Size
Specify a length for the string or integer.

Digits Before Decimal
Specify the number of digits that appear before the decimal.

Digits After Decimal
Specify the number of digits that appear after the decimal.

Auto Expand
Select this check box if the input needs to be expanded to fit the field definition.

Convert to Uppercase
Select this check box to convert the string to uppercase.

3 Click Save.

Defining a Factory track User Role
1 Open the User Extensions form.
2 Select a user record.
3 In the User Type field, select Administrator, Supervisor, or User. The type you specify will assign the

selected user to a group authorization that allows access to forms appropriate to that type.
• Administrators can access and update all forms.
• Supervisors can view most forms, and can enter and edit employee times but will not be able to edit

configuration and organization tables.
• Users can enter transaction information in real time but will not be able to edit records or modify

transaction times.

Specifying Alternate Labels
Use the Label Exceptions form to specify an alternate label to print for specific items or customers.

1 Open the Label Exceptions form.
2 To create a new alternate label, click New. To modify an existing alternate label, select it from the grid.
3 Specify this information:

Label Name
Select the name of the label to replace with an alternate label.

Exception Type
Select whether the alternate label is for an item or customer.
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Exception Key
Specify the item or customer account number.

Alter Label Name
Select the name of the alternate label to print.

4 Click Save.

Using Parameter Group Settings
Use the Parameter Group Settings form to view the parameters that are applicable to the Infor Factory Track
transactions and forms.

To view the particular transaction for a selected parameter group:

1 Select Open > Parameter Group Settings.
You can also access the form by selecting Master Explorer > Modules > Parameters > Parameter Group
Settings

2 Select the required Parameter Group.
The Parameters tab in the screen displays the respective parameters along with the parameter value
related to this Parameter Group.

3 Click Transactions tab.
The tab displays the grid with the associated transactions for the parameter group.

Using Parameter Group Setup Form
Use the Parameter Group Setup form to define parameter groups. These are created to allow standardization
of parameter settings across the entire Factory Track product.

Note: Only programmers who are authorized to customize the application must use the Parameter Group
Setup form. If any changes are made to this form, the application functions incorrectly.

To view the particular transaction for a selected parameter group:

1 Select Open > Parameter Groups Setup.
You can also access the form by selecting Master Explorer > Modules > Configuration > Development
> Parameter Groups Setup.

2 Click New.
3 Select the required ERP Type.
4 Add parameter ID using the Parameter Group Id tab.
5 Select the required Parm Group Label String.
6 Click Save.
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The respective Parameter Group Label column defaults the group label.

7 Select the required Parameter Group Label to view these values in the bottom grid of the form:
• Parameter Name
• Parameter Type
• Parameter Value
• Description
• Parent Parameter
• Parameter Sequence
• Form Label
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Chapter 8: Device Tracking Overview

You can use the device tracking system to manage devices. The device tracking system provides a check-in
system that tracks who is using a device and when it has been returned. You can also track device conditions,
such as lost or broken, and view device availability and activity histories. To configure and use the device
tracking system:

1 Create device types using the Device Types form.
See Defining Device Types.

2 Create devices using the Devices form.
See Adding and Modifying Devices.

3 Issue and return devices using the Device Allocation form and Device Allocation transaction. You can
view device usage and availability using the Current Device Usage form.
SeeIssuing and Returning Devices and Viewing Device Usage and Availability.

You can report devices as Lost, Found, Broken, and Fixed using the Devices form.

See Reporting Devices as Lost, Found, Broken, and Fixed.
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Chapter 9: Transaction processing

This chapter describes the transactions processes related to Factory Track LN.

Defining Transactions
Use the Transactions Setup form to define transactions for the Infor Factory Track application. For example,
you can add custom transactions to the application using this form. You can also configure settings for
transactions on this form.

Caution:  Only programmers who are authorized to customize your Infor Factory Track application should
use the Transaction Setup form. Changes made to this form can cause your application to function incorrectly.

1 Open the Transactions Setup form.
2 To add a new transaction, click Create a New Object or select a blank line from the grid. To modify an

existing transaction, select it from the grid.
3 Specify or review this information:

ERP Type
Select the ERP to which this parameter applies. If you are modifying an existing parameter, this field is
unavailable.

Transaction Name
Specify a name for this transaction. If you are modifying a core transaction that is pre-installed with the
application, this field is read only.

Transaction Form Name
Select the form name associated with the transaction.

Transaction Description
Specify a string and description for this transaction. The description will be visible to end users and
might be translated into another language. There are separate fields for the string and the description.

4 Optionally, to configure settings for this transaction, specify this information:

Trans Fill Whse
Select this check box to use the warehouse assigned to the user as the default warehouse. The user can
change this value.
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Show Success Message
Select this check box to show a success message when the transaction is successfully completed.

Applies To Order Types
Select this check box if there are specific order types that apply to this transaction.

Supports Label Printing
Select this check box if the transaction supports label printing.

Order Type Group
Specify the order type group used for this transaction. This field is only available if Applies To Order
Types is selected.

Default Order Type
Optionally, specify a default order type for the transaction. The user can change this value. This field is
only available if Applies To Order Types is selected.

5 Optionally, to configure label printing parameters for the selected transaction, click Label Print
Parameters. For more information about how to configure label printing parameters, see Configuring
Label Printing Settings for Specific Transactions, Warehouses, and Order Types.

6 On the Transaction Parameters tab, select a parameter or, to create a new parameter, select a blank
line on the grid.

7 Specify or review this information for each parameter you are modifying or creating on the Transaction
Parameters tab:

Parameter Name
Specify a name for the parameter. If you are modifying an existing parameter, this field is unavailable.

Parameter Type
Select a parameter type: String, Boolean, or Numeric.

Parameter Value
Optionally, specify a default value for this field. Leave blank to require users to specify the value.

Description
Specify a description for the parameter.

Parent Parameter
Optionally, specify a parent parameter. A parameter is only visible if its parent parameter is enabled.

Form Label
Specify a label to display to end users.

Parameter Sequence
Optionally, specify a sequence number to determine where this parameter should be displayed in the
parameter list. If you do not specify sequence numbers for parameters, they are displayed alphabetically.

8 If applicable, on the Order Type Parameters tab, select a parameter or, to create a new parameter,
select a blank line on the grid. The Order Type Parameters tab is only available if the Applies to Order
Types check box is selected.
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9 Specify or review this information for each parameter you are modifying or creating on the Order Type
Parameters tab:

Parameter Name
Specify a name for the parameter. If you are modifying an existing parameter, this field is unavailable.

Parameter Type
Select a parameter type: String, Boolean, or Numeric.

Parameter Value
Optionally, specify a default value for this field. Leave blank to require users to specify the value.

Description
Specify a description for the parameter.

Parent Parameter
Optionally, specify a parent parameter. A parameter is only visible if its parent parameter is enabled.

Form Label
Specify a label to display to end users.

Parameter Sequence
Optionally, specify a sequence number to determine where this parameter should be displayed in the
parameter list. If you do not specify sequence numbers for parameters, they are displayed alphabetically.

10 Order Types are driven by the Order Type Group associated with the transaction. The Order Types tab
is only available if the Applies to Order Types check box is selected.

11 Specify or review this information for each order type you creating:

Order Type
Specify the order type.

Description
Specify a description.

12 Click Save.

Configuring Allocate Release Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Allocate Release transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Allocate Release.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
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• If you are configuring general parameters, which are applicable by default in the application, the
Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Cart Location
The cart location to which to transfer items at the time of picking.

Show Inventory List after Partial Pick
Select this checkbox if the list of inventory must be displayed after a partial pick is performed.

Outbound Run Number
The default number for outbound runs.

Release Outbound
Select this checkbox to release the outbound allocation when items are picked.

Over Picking Allowed (Sales, Transfer, Production only)
Select this checkbox to allow users to pick more than the required quantity, in compliance with standard
Infor LN tolerance limits.

Stage Location
The staging location for items that are picked.

Input Zone
Select this checkbox to allow users to filter the pick list by zone.

No of Lines to Display
The number of order lines to be displayed.

Prefill Handling Unit Quantities
Select this checkbox if a picked HU must be pre-filled in the Quantity field automatically.

Prefill non-Handling Unit Quantities
Select this checkbox if a picked line must be automatically pre-filled when a HU is not picked.

Display Item Number
Select this checkbox to display the number of the item that is picked.

Scan Item Number
Select this checkbox to require the user to scan the item number. If the scanned item number does not
match the item number on the inventory line, the application displays an error message.

Display Location
Select this checkbox to display the location of the item being picked.

Infor Factory Track LN User Guide | 75DRAFT
 

Transaction processing



Scan Location
Select this checkbox to require the user to scan the location. If the scanned location does not match the
location on the inventory line, the application displays an error message.

Change Location
Select this checkbox to allow users to pick items from a location that is different from that on the inventory
line. If you select this checkbox, this parameter overrides the Scan Location parameter.

Display Lot Number
Select this checkbox to display the lot number of the item that is picked.

Scan Lot Number
Select this checkbox to scan the lot number. If the scanned lot number does not match the lot number
on the inventory line, the application displays an error message.

Change Lot Number
Select this checkbox to allow users to pick items with a lot number that is different from that on the
inventory line. If you select this checkbox, this parameter overrides the Scan Lot Number parameter.

Display Handling Unit
Select this checkbox to display the handling unit assigned to the item that is picked.

Scan Handling Unit
Select this checkbox to require the user to scan the handling unit. If the scanned handling unit does not
match the handling unit on the inventory line, the application displays an error message.

Change Handling Unit
Select this checkbox to allow users to pick items assigned to a handling unit that is different from that
on the inventory line. If you select this checkbox, this parameter overrides the Scan Handling Unit
parameter.

Display Date
Select this checkbox to display the inventory date of the item that is picked.

Scan Date
Select this checkbox to require the user to scan the inventory date. If the scanned inventory date does
not match the inventory date on the inventory line, the application displays an error message.

Change Inventory Date
Select this checkbox to allow users to pick items with an inventory date that is different from that on
the inventory line. If you select this checkbox, this parameter overrides the Scan Date parameter.

List by Work Center (Production only)
Select this checkbox to display open lines for the specified work center or order number range.

Enter Single Order Only
Select this checkbox if a range of orders is not required.

Match Handling Units
Select this checkbox if the picked Handling Unit must be matched with an existing shipment HU.
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Pick and Pack
Select this checkbox if the operator is allowed to build a 2-level Handling Unit structure when picking a
Handling Unit.

Shipment is Run Number
Select this checkbox if the shipment number must be used for the outbound run number.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Click Save

Configuring Approvals Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Approvals transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Approvals.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this checkbox to allow users to specify a Reference ID at the beginning of this transaction. For
more information, see Reference IDs on page 16.
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6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Filter by Warehouse
Select this checkbox to inspect items in the current warehouse.

Reject Code
The default reason code for rejections.

Allow Destroyed Qty Input
Select this checkbox to specify an item quantity to destroy.

Destroy Code
The default reason code for items destroyed during inspection.

Scrap Reason Code
The default reason code for scrapped items.

Putaway
Select this checkbox to allow users to perform putaway transactions from within this transaction. These
parameters are held at group level by default but can be copied to the transaction if required.

Release inbound
Select this checkbox to automatically release inbound orders for putaway. This parameter is only
displayed if the Putaway parameter is selected.

Default run no
This parameter is only displayed if the Putaway parameter is selected. This value is always used by the
transaction.

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to select putaway locations that are defined in Infor LN as fixed locations for the
item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
This parameter is only displayed if the Popup Location parameter is selected. Select this checkbox to
display empty locations in the popup list.
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Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory approval for existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location. This parameter is only displayed if the Popup
Location parameter is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if they have a quantity of zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected. 

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
This parameter is only displayed if the Prefill Locations parameter is selected. Select this checkbox to
specify a default location put away location to use for this location.

Default Location
This parameter is only displayed if the Use Default Location parameter is selected. Specify a default
put away location for this transaction.

Use fixed locations
This parameter is only displayed if the Prefill Locations parameter is selected. Select this checkbox to
use the first fixed location of the item as the default put away location for this transaction. If the item
has no fixed locations, the Location field is not specified.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.
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Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from within this transaction.

Print Handling Unit Labels before Crossdock
Select to print handling unit barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

Print Serial Labels before Crossdock
Select to print serial number barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

7 Select Label Print Parameters to configure label printing parameters for this transaction. See Configuring
Label Printing Settings for Specific Transactions, Warehouses, and Order Types for more information.

8 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

9 Click Save.

Configuring As Built Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the As Built transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > As Built.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Specify this information:

Fill Warehouse
This parameter has no effect for this transaction.

Successful Message
Select this checkbox to show a success message when the transaction is successfully completed.

6 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Create As-Built Record
Select this checkbox to allow users to create as-built records even if not required by the order.

Create Lot Number
Select this checkbox to allow users to create lot numbers. Clear this checkbox to use existing lot numbers.

Create Serial Number
Select this checkbox to allow users to create serial numbers. Clear this checkbox to use existing serial
numbers.

7 Click Save.

Configuring ASN Receipt Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the ASN Receipt transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > ASN Receipt.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:
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Reference ID in Use
Select this checkbox to allow users to specify a Reference ID at the beginning of this transaction. For
more information, see Reference IDs on page 16.

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:
Note: The order type parameters are only applicable to this transaction when a user is receiving an
individual ASN line.

Filter by Warehouse
Select this checkbox to receive items in the current warehouse.

Override LN Activities
Select this checkbox to override any LN activities that interfere with this transaction.

Execute LN Activities
Select this checkbox to run any subsequent automatic tasks within the current transaction. If any task
that is run within the transaction fails, the entire transaction fails and the application displays an error
message. Clear to run subsequent automatic tasks outside of the current transaction. If tasks that are
run outside of the transaction fail, the application displays no error message is displayed.

Set Pack Slip Quantity to Open Quantity
Select this checkbox to allow users to specify the unit of measure with which to receive items. For
example, if a conversion factor specifying that one box equals five pieces is defined in Infor LN, the user
can receive an item quantity of one box instead of five pieces.

Allow User to Enter Final Receipt
Select this checkbox to allow users to provide a final receipt for the transactions.

Input Lot Certificate Code
Select this checkbox to allow the user to specify a certificate code, linking a document to the lot number.

Enter Received Quantity
Select this checkbox to require users to specify the received quantity. Clear to automatically receive the
quantity listed on the packing slip.

Prefill Received Quantity with Pack Slip Quantity
This parameter is only displayed if the Enter Received Quantity parameter is selected. Select this
checkbox to use the packing slip quantity as the default value for the Received Quantity field. The user
can change this value.

Enter Inspection Flag
Select this checkbox to allow users to specify whether to inspect received items. Clear this checkbox to
inspect or not inspect items based on their designation in Infor LN.

Enter Inventory Date
Select this checkbox to allow users to specify an inventory date for date-controlled items that are received.
Clear this checkbox to always use the current date added to the shelf life of the item for the inventory
date.

Enter Receipt Date
Select this checkbox to allow the user to specify the receipt date.
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Inventory Time
The time to record for any date-controlled items that are received.

Input UOM
Select this checkbox to allow users to specify the unit of measure with which to receive items. For
example, if a conversion factor specifying that one box equals five pieces is defined in Infor LN, the user
can receive an item quantity of one box instead of five pieces.

Receipt Series in Use
Select this checkbox to enable the Receipt Series field in the transaction form.
Note: If this parameter is cleared, the application defaults the receipt series and does not allow the
override option for the receipt series that is used in LN.

Receipt Series
The default value type available in the Receipts Series List form.
Note: 
• This field is enabled only if the Receipt Series in Use parameter is selected.
• Based on the specified value, the related transaction form populates the same Receipt series type.

Putaway
Select this checkbox to allow users to perform put away transactions from within this transaction. These
parameters are applied at group level by default but can be copied to the transaction if required.

Release inbound
This parameter is only displayed if the Putaway parameter is selected. Select this checkbox to
automatically release inbound orders for putaway.

Default run no
This parameter is only displayed if the Putaway parameter is selected. This value is always used by the
transaction.

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to only allow users to select put away locations that are defined in Infor LN as fixed
locations for the item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.
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Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Consolidate Inventory
Select this checkbox to direct Putaway for existing stocks of the same item. If you select this parameter,
the options list only displays locations containing a positive quantity of the item to be transferred. Users
can still manually specify any location. This parameter is only displayed if the Popup Location parameter
is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if they have a quantity of zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.

Default Location
This parameter is only displayed if the Use Default Location parameter is selected. Specify a default
put away location for this transaction.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.
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Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from within this transaction.

Print Handling Unit Labels before Crossdock
Select to print handling unit barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

Print Serial Labels before Crossdock
Select to print serial number barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Click Save.

Configuring Asset Tag Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Asset Tag transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Asset Tag.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Validate Asset Tag
Select this checkbox to indicate if the application must verify that the asset tag is not currently assigned
to a Handling Unit.

6 Click Save.

Configuring Close Handling Unit Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Close Handling Unit transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Close Handling Unit.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Consignment Receipt Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Consignment Receipt transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > ASN Receipt.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
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• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse
is displayed in the Warehouse field.

• If you are configuring general parameters, which are applicable by default in the application, the
Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you should also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to select putaway locations that are defined in Infor LN as fixed locations for the
item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
This parameter is only displayed if the Empty Locations parameter is selected. Select this checkbox to
only display locations that are acceptable for the item in the popup list.

Consolidate Inventory
Select this checkbox to direct receipt to existing stocks of the same item. If you select this parameter,
the options list only displays locations containing a positive quantity of the item to be transferred. Users
can still manually specify any location. This parameter is only displayed if the Popup Location parameter
is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.
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Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if the quantity of item is zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
The default put away location for this transaction. This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, based on the
Highest Inventory First parameter selected, for the item. This parameter is only displayed if the Prefill
Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Create Handling Unit Parameters
Use the Transaction Set Maintenance form to configure parameters for the Create Handling Unit transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Create Handling Unit.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
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Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Handling unit mask
The mask code for automatically generated handling unit numbers.

Create parent
Select this parameter to allow a new parent handling unit to also be created when a handling unit is
created during this transaction.

Input Package Definition
Select this parameter to allow a package definition to be assigned to a new handling unit.

Input Packaging Item
Select this parameter to allow a packing item to be assigned to a new handling unit.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Cross Docking Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Cross Docking transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Cross Docking.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 On the Transaction Parameters tab, in the Parameter and Value columns, configure these parameters:

Always Scan Serial/Lot
Select this checkbox to always require users to scan serial and lot numbers. Clear this checkbox to
automatically specify serial and lot numbers when users are cross docking the full quantity of an item
from a stock point.

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Crossdock Location
The temporary location status for cross docking items prior to delivery to the staging area.

Inbound Run Number
The default number for inbound runs.

Outbound Run Number
The default number for outbound runs.

Release Outbound
Select this checkbox to automatically release outbound orders for shipment.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

9 Click Save.

Configuring Customer Returns Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Customer Returns transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Customer Returns.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
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Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Sales Order Series
The order series to use when generating sales orders for returns.

Customer Returns Sales Order Type
The order type to use when generating sales orders for returns.

Sales Office
The sales office to use when generating sales orders for returns.

Print SO
Select this checkbox to print sales orders when generated.

Device
The device to use to print sales orders. This parameter is only displayed if the Print SO parameter is
selected.

Release to Warehousing?
Select this checkbox to release newly-created sales orders to warehousing.

Receive Inventory?
Select this checkbox to physically receive items when they are returned. Clear this checkbox to only
create an order line for the items.

Putaway
Select this checkbox to perform putaway transactions from within this transaction. These parameters
are applicable at group level by default but can be copied to the transaction if required.

Release inbound
Select this checkbox to automatically release inbound orders for putaway. This parameter is only
displayed if the Putaway parameter is selected.

Default run no
This value is always used by the transaction. This parameter is only displayed if the Putaway parameter
is selected.

Popup Location
Select this checkbox to allow users to select putaway locations from a list instead of scanning them.  If
you select this checkbox, you must also select one of these parameters:
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• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to only allow users to select putaway locations that are defined in Infor LN as fixed
locations for the item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Consolidate Inventory
Select this checkbox to suggest existing locations containing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
putaway. Users can still manually specify any location. This parameter is only displayed if the Popup
Location parameter is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if the quantity of item is zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.
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Default Location
The default putaway location for this transaction. This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default putaway location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, based on the
Highest Inventory First parameter selected, for the item. This parameter is only displayed if the Prefill
Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

6 Sselect Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Cycle Count Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Cycle Count transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Cycle Count.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.
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5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Display Item Number
Select this checkbox to display the counted item number.

Scan Item Number
Select this checkbox to scan the item number. If the scanned item does not match the count item, the
application displays a message.

Display Location
Select this checkbox to display the location of the counted item.

Scan Location
Select this checkbox to scan the location. If the scanned location does not match the location of the
count item, the application displays a message.

Display Lot Number
Select this checkbox to display the lot number of the counted item.

Scan Lot Number
Select this checkbox to scan the lot number. If the scanned lot number does not match the lot number
of the count item, the application displays a message.

Display Date
Select this checkbox to display the inventory date of the counted item.

Scan date
Select this checkbox to scan the inventory date. If the scanned inventory date does not match the
inventory date of the count item, the application displays a message.

Display Handling Unit
Select this checkbox to display the handling unit assigned to the counted item.

Scan Handling Unit
Select this checkbox to scan the handling unit. If the scanned handling unit does not match the handling
unit of the count item, the application displays a message.

Reset System Count
Select this checkbox to reset the recorded inventory quantity at the time that items are counted.

Create Serial Numbers
Select this checkbox to allow the application to create new serial numbers at the time that items are
counted.

No of Lines to Display
The number of uncounted cycle count lines to display simultaneously.

Default Reason Code
The default reason code for count quantities that exceed that variance tolerance of an item.

Bypass List Page
Select this checkbox if the cycle count details are to be displayed only on first entry of the transaction.
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6 Click Save.

Configuring Elapsed Hours Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Elapsed Hours transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Elapsed Hours.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure the available parameters on the Transaction Parameters tab, in the Parameter and Value
columns. These parameters are applicable at group level by default but can be copied to the transaction
if required.

Is Employee Code Numeric
Select this checkbox if employee badge numbers contain only numbers. Clear this checkbox is employee
badge numbers are alphanumeric.

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Input Hourly Labor Type
Select this checkbox to specify an hourly labor type. Clear this checkbox to automatically use the default
value.

Input Work Center
Select this checkbox to specify a work center. Clear this checkbox to automatically use the default value.

Input Cost Component
Select this checkbox to specify an hourly labor type. Clear this checkbox to automatically use the default
value.

Input Machine
Select this checkbox to specify a machine code. Clear this checkbox to automatically use the default
value.

Infor Factory Track LN User Guide | 95DRAFT
 

Transaction processing



Input Task
Select this checkbox to specify a task. Clear this checkbox to automatically use the default value.

Report Order if Last Operation
Select this checkbox to report to the order that parts are completed. This parameter only applies when
the user is reporting the last operation on the job.

Report Production to Inventory
Select this checkbox if completed quantities are to be placed into inventory. This parameter only applies
when the user is reporting the last operation on the job and the Report Order if Last Operation is enabled.

Report Stop Details
Select this checkbox to specify completed quantities when reporting quantities for a job.

Report Setup
Select this checkbox to report set up time.

Report Complete Flag
Select this checkbox to specify when an operation is competed. Clear this checkbox to complete
operations using the Infor LN interface.

Allow Over Reporting
Select this checkbox to complete operation quantities that exceed the quantity specified on the order.

Allow Rejects
Select this checkbox to reject operation quantities.

Default Reason Code
The default reason for rejections. Users can change this value.

Back Flush
Select this checkbox to automatically issue materials to orders. Materials on the bill of materials that
are designated for back flushing are issued.

Calculate Machine Hours based on Machine Occupation
Select this checkbox to calculate machine hours based on the machine occupation settings defined for
the current operation.

Check Order Status
Select this checkbox to validate the order and operation when scanned. Clear this checkbox to only
validate the operation when scanned.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Click Save.
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Configuring Global Transfer Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the global Transfer transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Global Transfer.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Warehouse Order Type
The order type used in Infor LN to generate warehouse order used for the transfer.

6 Click Save.

Configuring Handling Unit Inquiry Transaction Parameter
Use the Transaction Set Maintenance form to configure parameters for the Handling Unit Inquiry transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Handling Unit Inquiry.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.
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Configuring Inventory Adjustment Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Inventory Adjustment transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Inventory Adjustment.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this parameter to specify a reference ID. See Reference IDs on page 16 for more information.

Allow Handling Unit Input
Select this parameter to specify a single handling unit instead of specifying the item number and each
stock point characteristic. See Handling Units on page 13 for more information.

Allow Serial Number Input
Select this parameter to allow users to write off a single, serial-controlled item without using the Serial/Lot
Entry screen.

Default Reason Code
The default reason for inventory adjustments. Users can change this value.

Input UOM
Select this parameter to specify the unit of measure with which to write off items. For example, if a
conversion factor specifying that one box equals five pieces has been defined in Infor LN, the user can
write off an item quantity of one box instead of five pieces.

6 Click Save.

Configuring Inventory Transfer Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Inventory Transfer transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Inventory Transfer.
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2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned
to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this checkbox to specify a Reference ID at the beginning of this transaction. For more information,
see Reference IDs on page 16.

Allow Handling Unit Input
Select this checkbox to specify a handling unit instead of specifying the item number and each stock
point characteristic.

Default order type for the transaction
The default order type to use for inventory transfers.

PreFill Lot
Select this checkbox to select lot numbers from a list. Clear this checkbox to scan the lot number.

PreFill Date
Select this checkbox to select inventory dates from a list. Clear this checkbox to scan inventory dates.

Popup Location
Select this checkbox to select put away locations from a list instead of scanning them. If you select this
checkbox, you must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to only allow users to select putaway locations that are defined in Infor LN as fixed
locations for the item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.
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Check Capacity
Select this checkbox to only display locations with sufficient quantity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory transfers to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location. This parameter is only displayed if the Popup
Location parameter is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if they have a quantity of zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.

Default Location
The default putaway location for this transaction This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.
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Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity,based on the
Highest Inventory First parameter is selected, of the item. This parameter is only displayed if the Prefill
Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Issue Material Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Issue Material transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Issue Material.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Generate Outbound
Select this checkbox to generate an outbound allocation when materials are issued.

Prefill First Stock Point
Select this checkbox to pre-fill the details of the first stock point. This field can be modified. If the checkbox
is cleared, the field is unspecified and can be specified with the values manually.

Prefill Quantity
Select this checkbox to pick the prefill quantity. The Quantity field is prefilled with the required quantity
or the available quantity, whichever is less. If the checkbox is cleared, the field is unspecified and can
be specified with the values manually.
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Run Number
The outbound run number that is used when creating an outbound advice.

Release Outbound
Select this checkbox to release the outbound allocation when materials are issued.

Cart Location
The default cart location.

Stage Location
The default staging location.

Change Location
Select this checkbox to allow users to pick items from a location that is different from that on the inventory
line.

Change Lot Number
Select this checkbox to allow users to pick items with a lot number that is different from that on the
inventory line.

Change Handling Unit
Select this checkbox to allow users to pick items assigned to a handling unit that is different from that
on the inventory line.

Change Inventory Date
Select this checkbox to allow users to pick items with an inventory date that is different from that on
the inventory line.

Change Serial Numbers
Select this checkbox to allow users to pick items with a serial number that is different from that on the
outbound advice.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Inventory Write Off Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Inventory Write Off transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Inventory Write Off.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
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• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse
is displayed in the Warehouse field.

• If you are configuring general parameters, which are applicable by default in the application, the
Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this parameter to specify a reference ID. See Reference IDs on page 16 for more information.

Allow Handling Unit Input
Select this parameter to specify a single handling unit instead of specifying the item number and each
stock point characteristic. See Handling Units on page 13 for more information.

Allow Serial Number Input
Select this parameter to write off a single, serial-controlled item without using the Serial/Lot Entry
screen.

Default Reason Code
The default reason for inventory adjustments. Users can change this value.

Input UOM
Select this parameter to allow users to specify the unit of measure with which to write off items. For
example, if a conversion factor specifying that one box equals five pieces is defined in Infor LN, the user
can write off an item quantity of one box instead of five pieces.

6 Click Save.

Configuring Inventory Write On Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Inventory Write On transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Inventory Write On.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Handling Unit Input
Select this parameter to specify a single handling unit instead of specifying the item number and each
stock point characteristic. See Handling Units on page 13 for more information.

Allow Serial Number Input
Select this parameter to write on a single, serial-controlled item without using the Serial/Lot Entry
screen.

Default Reason Code
The default reason for inventory adjustments. Users can change this value.

Input UOM
Select this parameter to allow users to specify the unit of measure with which to write on items. For
example, if a conversion factor specifying that one box equals five pieces is defined in Infor LN, the user
can write off an item quantity of one box instead of five pieces.

Add Lot
Select this parameter to create new lots using this transaction.

6 Click Save.

Configuring Item Inquiry Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Item Inquiry transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Item Inquiry.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:
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Show Inventory in all Locations
Select this checkbox to display inventory in all locations. Clear this checkbox to exclude inventory in
receipt, inspection, staging, and rejection locations.

6 Click Save.

Configuring Job Booking Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Job Booking transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Job Booking.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Is Employee Code Numeric
Select this checkbox if employee badge numbers contain only numbers. Clear this checkbox if employee
badge numbers are alphanumeric.

6 Configure the available order type-specific parameters on the Order Type Parameters tab, in the
Parameter and Value columns. These parameters are applicable at group level by default but can be
copied to the transaction if required.

Input Hourly Labor Type
Select this checkbox to specify an hourly labor type. Clear this checkbox to automatically use the default
value.

Input Work Center
Select this checkbox to specify a work center. Clear this checkbox to automatically use the default value.

Input Cost Component
Select this checkbox to specify an hourly labor type. Clear this checkbox to automatically use the default
value.
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Input Machine
Select this checkbox to specify a machine code. Clear this checkbox to automatically use the default
value.

Input Task
Select this checkbox to specify a task. Clear this checkbox to automatically use the default value.

Report Order if Last Operation
Select this checkbox to report to the order that parts are completed. This parameter only applies when
the user is reporting the last operation on the job.

Report Production to Inventory
Select this checkbox if completed quantities are to be placed into inventory. This parameter only applies
when the user is reporting the last operation on the job and the Report Order if Last Operation is enabled.

Report Stop Details
Select this checkbox to specify completed quantities when stopping jobs.

Report Setup
Select this checkbox to allow users to report setup time.

Report Complete Flag
Select this checkbox to specify when an operation is competed. Clear this checkbox to complete
operations using the Infor LN interface.

Allow Over Reporting
Select this checkbox to complete operation quantities that exceed the quantity specified on the order.

Allow Rejects
Select this checkbox to reject operation quantities.

Default Reason Code
The default reason for rejections. Users can change this value.

Back Flush
Select this checkbox to automatically issue materials to orders. Materials on the bill of materials that
are designated for back flushing are issued.

Calculate Machine Hours based on Machine Occupation
Select this checkbox to calculate machine hours based on the machine occupation settings defined for
the current operation.

Check Order Status
Select this checkbox to validate the order and operation when scanned. Clear this checkbox to only
validate the operation when scanned.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.
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Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Click Save.

Configuring Kanban Cancel Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Cancel transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Cancel.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Kanban Create Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Create transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Create.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.
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4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Temporary Kanban IDs in Use
Select this check box to create temporary Kanbans.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Kanban Delivery Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Delivery transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Delivery.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

User Input To Warehouse
Select this checkbox to scan the warehouse. If the scanned warehouse does not match the Kanban stock
warehouse, the application displays an error message.

User Input To Location
Select this checkbox to scan the location. If the scanned location does not match the Kanban stock
location, the application displays an error message.

User Input Kanban Location
Select this checkbox to scan the Kanban location. If the scanned location does not match the Kanban
stock location, the application displays an error message.

Warehouse Order Type
The order type to use to transfer the Kanban from the original location to the destination.
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6 Click Save.

Configuring Kanban Reinstate Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Reinstate transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Reinstate.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

6 Click Save.

Configuring Kanban Request Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Request transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Request.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.
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4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Kanban Reset Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Reset transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Reset.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

6 Click Save.

Configuring Kanban Status Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Kanban Status transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Kanban Status.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Kanban Print Transaction Parameters
Use the Transaction Set Maintenance form to configure the parameters for the Kanban Print transaction.

1 Select Form > Open > Transaction Set Maintenance form.
2 Select Kanban Print in the Transaction Name column.
3 Specify this information:

Warehouse
The warehouse for which you are configuring the transaction parameter.

Note: If you are configuring general parameters, which are applicable by default throughout the
application, the Warehouse field is blank and disabled.

Fill Warehouse
Select this check box to default the warehouse specified for the user on the Warehouse Parameters form.

Successful Message
If this check box is selected, a message is displayed indicating that the transaction is processed
successfully.

Transaction Name
The name of the transaction.

Default Order Type
The default order type for the transaction.

4 Select Label Print Parameters on the Transaction Parameters tab to configure the transaction
parameters required for label printing.

5 Click Save

Configuring Link Handling Unit Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Link Handling Unit transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Link Handling Unit.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
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Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Handling unit mask
The mask code for automatically generated handling unit numbers.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Loading Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Loading transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Loading.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Specify this information for each order type on the Transaction Parameters tab:

Ignore Sealing Check
Select this box, to load a container irrespective of the not sealed status.
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Allow Unpicked Lines
Select this checkbox to load the unpicked lines in the transaction.

Load by Shipment
Select this checkbox to use shipment numbers for loading.

Dock Options
Select one of the Dock Options for loading transaction:
• Use Shipment as Dock- Select this checkbox to use the Shipment Number as the Dock Number.
• Use Load as Dock- Select this checkbox to use the Load Number as the Dock Number.
• Manually Enter- Select this checkbox to manually provide the Dock Number.
• Ignore Dock Check & Default Dock- Select this checkbox, to avoid providing dock number manually

at time of loading.

Asset Tag
Select this checkbox to allow the Asset Tag of the Handling Unit to be specified or modified.

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save.

Configuring Location Inquiry Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Location Inquiry transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Location Inquiry.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:
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Show Inventory in all Locations
Select this checkbox to display inventory in all locations. Clear this checkbox to exclude inventory in
receipt, inspection, staging, and rejection locations.

5 Click Save.

Configuring Machine Data Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Machine Data transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Machine Data.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.

Refresh Interval
Select this checkbox for specifying the amount of time, in seconds, that the application waits before
refreshing the transaction form.

6 Configure label printing parameters for this transaction on the Order Type Parameters tab, in the
Parameter and Value columns. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Manage Team Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Manage Team transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Manage Team.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
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Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Calculate Production Machine Hours based on Machine Occupation
When an employee leaves a team, all active jobs linked to that employee are automatically stopped.
Select this check box to calculate the effective machine hours for stopped production operations based
on the machine occupation settings defined for that operation.

Calculate PCS Machine Hours based on Machine Occupation
When an employee leaves a team, all active jobs linked to that employee are automatically stopped.
Select this check box to calculate the effective machine hours for stopped PCS projects based on the
machine occupation settings defined for that PCS project.

6 Click Save.

Configuring OEE Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the OEE transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > OEE.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.
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Grade 1 OEE
Select this checkbox to enable the threshold for the highest level of performance.

OEE Threshold
Provide the OEE value which is the threshold for the highest level of performance.

OEE Color
• Red
• Green
• Blue
• Yellow

Grade 2 OEE
Select this checkbox to enable the threshold for the medium level of performance.

OEE Threshold
Provide the OEE value which is the threshold for the medium level of performance.

OEE Color
• Red
• Green
• Blue
• Yellow

Grade 3 OEE
Select this checkbox to enable the threshold for the lowest level of performance.

OEE Threshold
Provide the OEE value which is the threshold for the lowest level of performance.

OEE Color
• Red
• Green
• Blue
• Yellow

6 Configure label printing parameters for this transaction on the Order Type Parameters tab, in the
Parameter and Value columns. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Packing by Order Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Packing by Order transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Packing by Order.
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2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned
to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save.

Configuring Packing by Shipment Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Packing by Shipment transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Packing by Shipment.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

Infor Factory Track LN User Guide | 117DRAFT
 

Transaction processing



5 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information. Also specify this information:

Route to Sealing for Directed Packs
Select this checkbox, if Directed Packs are to be automatically routed to the Sealing Transaction.

Seal Pre-Packed Containers
Select this checkbox to automatically seal the Pre-Packed Containers while scanning.

Freeze Shipment Lines
Select this checkbox to automatically freeze the contents of the Sealed Pre-Packed Containers.
Note: This field is enabled, only if the Seal Pre-Packed Containers option is selected.

Scan Handling Unit
Select this checkbox to force the scan of the Handling Unti being packed rather than just confirming
that the Handling Unit is packed.

Asset Tag
Select this checkbox to allow the Asset Tag to be updated on the Handling Unit that is shipped.

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save .

Configuring Packing Inquiry Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Packing Inquiry transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Packing Inquiry.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.
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4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this to use the
default parameter settings for this order type.

6 Click Save.

Configuring Physical Inventory Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Physical Inventory transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Physical Inventory.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Handling Unit Input
Select this checkbox to allow users to specify a handling unit instead of specifying the item number and
each stock point characteristic.

Default reason code
The default reason code to use for any count variances.

Default Accumulate Value
Select this parameter to use Yes as the default value for the Accumulate field. Clear this field to use No
as the default value.
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Retain Cycle Count Order
Select this parameter to retain cycle count order numbers after a successfully count. Clear this parameter
to remove cycle count order number after a counts are completed.

Inventory Time
The inventory time to assign to stock points that are created as part of a count.

Add Lot
Select this checkbox to add lot numbers during a count.

Create Serial Numbers
Select this checkbox to create serial numbers during a count.

Reset System Count
Select this checkbox to reset the system quantity when a count is started.

6 Click Save.

Configuring Picking Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Picking transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Picking.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Picking Option
Select one of the Default Picking Options:
• Default by Order - Select this box to use the "by order" picking method by default. The user can

change this method.
• Default by Run - Select this box to use the "by run" picking method by default. The user can change

this method.
• Default by Mission - Select this box to use the "by mission" picking method by default. The user can

change this method.
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Filter by Warehouse
Select this checkbox to only allow users to pick items in the current warehouse.

Serial Picking Implemented
Select this checkbox to allow users to pick serialized items.

Lost Material Order Type
The order type to use for lost material.

Consolidate Picks
Select this checkbox to allow identical picks to be summarized in a single line on the display.

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Number of Rows in List
The maximum number of rows to display in the picking list. If the number of items available for picking
exceed this number, the list is truncated. As items are picked, these are removed from the list, providing
space for the truncated items to be displayed.

Cart Location
The cart location to which to transfer items at the time of picking.

Stage Location
The staging location for items that are picked.

Lost Material in Use
Select this checkbox to allow users to report lost material during picking. If you select this checkbox,
you must specify a lot material warehouse, a lost material location, or both.

Lost Material Warehouse
The warehouse to which lost material is transferred. Optionally, leave this field blank to use the original
warehouse to hold lost material. This parameter is only displayed if the Lost Material in Use parameter
is selected.

Lost Material Location
The location to which lost material is transferred. Optionally, leave this field blank to use the original
location to hold lost material. This parameter is only displayed if the Lost Material in Use parameter is
selected.

Over Picking Allowed (Sales, Transfer, Production only)
Select this checkbox to allow users to pick more than the required quantity, in compliance with standard
Infor LN tolerance limits.

Cascade
Select this checkbox to take over picking into account for other advice lines. Clear this checkbox to
prevent over picking for one advice line from affecting any others. This parameter is only displayed if
the Over Picking Allowed (Sales, Transfer, Production only) parameter is selected.

Release Outbound
Select this checkbox to release the outbound advice when items are picked.

Infor Factory Track LN User Guide | 121DRAFT
 

Transaction processing



Display Item Number
Select this checkbox to display the number of the item that is picked.

Scan Item Number
Select this checkbox to require the user to scan the item number. If the scanned item number does not
match the item number on the pick list, the application displays and error message.

Display Location
Select this checkbox to display the location of the item that is picked.

Scan Location
Select this checkbox to require the user to scan the location. If the scanned location does not match the
location on the pick list, the application displays and error message.

Change Location
Select this checkbox to allow users to pick items from a location that is different from that on the pick
list. If you select this checkbox, this parameter overrides the Scan Location parameter.

Display Lot Number
Select this checkbox to display the lot number of the item that is picked.

Scan Lot Number
Select this checkbox to require the user to scan the lot number. If the scanned lot number does not
match the lot number on the pick list, the application displays and error message.

Change Lot Number
Select this checkbox to allow users to pick items with a lot number that is different from that on the pick
list. If you select this checkbox, this parameter overrides the Scan Lot Number parameter.

Display date
Select this checkbox to display the inventory date of the item that is picked.

Scan Date
Select this checkbox to require the user to scan the inventory date. If the scanned inventory date does
not match the inventory date on the pick list, the application displays and error message.

Change Inventory Date
Select this checkbox to allow users to pick items with an inventory date that is different from that on
the pick list. If you select this checkbox, this parameter overrides the Scan Date parameter.

Display Handling Unit
Select this checkbox to display the handling unit assigned to the item that is picked.

Scan Handling Unit
Select this checkbox to require the user to scan the handling unit. If the scanned handling unit does not
match the handling unit on the pick list, the application displays and error message.

Change Serial Numbers
Select this checkbox to allow users to pick items with a serial number that is different from that on the
outbound advice.
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Display Destination Location
Select this check box to display the destination location.

Allow Destination to be Changed
Select this check box to allow users to change the destination location.
Note: User can change the destination location if:
• the Release Outbound and Display Destination Location parameters are selected for this

transaction
• the From and To warehouses are not the same.

7 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

8 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

9 Click Save.

Configuring Print Item Labels Transaction Parameters
Use the Transaction Set Maintenance form to configure the parameters for the Print Item Labels transaction.

1 Select Form > Open > Transaction Set Maintenance form.
2 Select Print Item Labels in the Transaction Name column
3 Specify this information:

Warehouse
The warehouse for which you are configuring the transaction parameter.

Note: If you are configuring general parameters, which are applicable by default throughout the
application, the Warehouse field is blank and disabled.

Fill Warehouse
Select this check box to default the warehouse specified for the user on the Warehouse Parameters form.

Successful Message
If this check box is selected, a message is displayed indicating that the transaction is processed
successfully.

Transaction Name
The name of the transaction.
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Default Order Type
The default order type for the transaction.

4 Select Label Print Parameters on the Transaction Parameters tab to configure the transaction
parameters required for label printing. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

5 Click Save.

Configuring Putaway Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Putaway transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Putaway.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Putaway Option
Select One of the Putaway Method Options:
• Putaway by Order No - Select this checkbox to display items to be put away when the user scans

the order number.
• Putaway by Receipt No - Select this checkbox to display items to be put away when the user scans

the receipt number.
• Putaway by Storage List - Select this checkbox to use the Storage List logic in Infor LN for item put

away.

Putaway by Storage List
Select this checkbox to use the Storage List logic in Infor LN for item put aways.

Reference ID in Use
Select this checkbox to allow users to specify a Reference ID at the beginning of this transaction. For
more information, see Reference IDs on page 16.
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6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Input UOM
Select this checkbox to only allow users to specify a unit of measure.

Putaway by Order Unit
Select this checkbox to sort the put away item list by order. Clear this checkbox to sort the list by location.

Putaway
Putaway parameters are stored at a Group level for consistency but can be copied down to the individual
transaction if required.

Release inbound
Select this checkbox to automatically release inbound orders for put away.

Default run no
The default run number for put aways.

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you should also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
Select this checkbox to only allow users to select put away locations that are defined in Infor LN as fixed
locations for the item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list.This parameter is only displayed if the
Popup Location parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
This parameter is only displayed if the Empty Locations parameter is selected. Select this checkbox to
only display locations that are acceptable for the item in the popup list.

Consolidate Inventory
Select this checkbox to direct inventory putaway to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location. This parameter is only displayed if the Popup
Location parameter is selected.
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Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if they have a quantity of zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you should also select
one of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.

Default Location
The default put away location for this transaction This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
This parameter is only displayed if the Prefill Locations parameter is selected. Select this checkbox to
use the first fixed location of the item as the default put away location for this transaction. If the item
has no fixed locations, the Location field will be blank.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from within this transaction.

Print Handling Unit Labels before Crossdock
Select to print handling unit barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.
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Print Serial Labels before Crossdock
Select to print serial number barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

7 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

8 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

9 Click Save .

Configuring Receipt Label Print Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Receipt Label Print transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Receipt Label Print.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. The Label Print Parameters must be set for this transaction to work.See
Configuring Label Printing Settings for Specific Transactions, Warehouses, and Order Types for more
information.

6 Click Save.
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Configuring Receipts Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Receipts transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Receipt.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.

Reference ID in Use
Select this checkbox for specifying a Reference ID at the beginning of this transaction. For more
information, see Reference IDs on page 16

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns.
Note: The order type parameters are only applicable to this transaction when a user is receiving an
individual receipt line.

Filter by Warehouse
Select this checkbox for receiving items in the assigned warehouse.

Override LN Activities
Select this checkbox to override the LN activities that interfere with this transaction.

Execute LN Activities
Select this checkbox to run the related tasks within the current transaction. If the task is not performed,
the entire transaction fails, and the application displays an error message.
Note: Clear this checkbox to run subsequent automatic tasks that are not included in the current
transaction.

Set Pack Slip Quantity to Open Quantity
Select this checkbox for specifying the unit of measure(UOM) to receive items. For example, if a one box
has five pieces as defined in Infor LN, the user can receive an item quantity of one box and not five
individual pieces.

Allow User to Enter Final Receipt
Select this checkbox for providing a final receipt for the transactions.
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Input Lot Certificate Code
Select this checkbox for specifying a certificate code, that is used in linking a document to the item lot
number.

Enter Received Quantity
Select this checkbox to specify the received quantity. Clear this checkbox to automatically receive the
quantity listed on the packing slip.

Prefill Received Quantity with Pack Slip Quantity
Select this checkbox to use the packing slip quantity as the default value for the Received Quantity
field.
Note: 
• This parameter is only displayed if the Enter Received Quantity parameter is selected.
• You can change this value.

Enter Inspection Flag
Select this checkbox, whether to inspect received items. Clear this checkbox to inspect or do not inspect
items based on the assigned roles in Infor LN.

Include Fully Received Open Inbound Lines
Select this checkbox to display all the lines for an order, even if received fully.

Enter Inventory Date
Select this checkbox for specifying an inventory date for date-controlled items that are received. Clear
this checkbox to always use the current date added to the shelf life of the item for the inventory date.

Enter Receipt Date
Select this checkbox to specify the receipt date.

Enter Kanban ID
Select this checkbox to scan Kanban IDs in place of order and item numbers.

Inventory Time
Set a time to record for any date-controlled items that are received.

Input UOM
Select this checkbox to specify the unit of measure(UOM) used to receive items. For example, if a one
box has five pieces as defined in Infor LN, the user can receive an item quantity of one box and not five
individual pieces.

Receipt Series in Use
Select this checkbox to enable the Receipt Series field in the transaction form.
Note: If this parameter is cleared, the application defaults the receipt series and does not allow the
override option for the receipt series that is used in LN.

Receipt Series
The default value type available in the Receipts Series List form.
Note: 
• This field is enabled only if the Receipt Series in Use parameter is selected.
• Based on the specified value, the related transaction form populates the same Receipt series type.
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Putaway
Select this checkbox to perform putaway transactions within this transaction. Putaway parameters are
stored at a Group level for consistency but can be copied down to the individual transaction if required.

Release inbound
Select this checkbox to automatically release inbound orders for putaway.
Note: This parameter is only displayed if the Putaway parameter is selected.

Default run no
The run number associated to the transaction. This parameter value is always used by the transaction.
Note: This parameter is only displayed if the Putaway parameter is selected.

Popup Location
Select this checkbox to locate the putaway locations from the available list.
Note: 
• This parameter is only displayed if the Putaway parameter is selected.
• If you select this checkbox, you should also select one of these parameters:

Use fixed locations
Use empty locations
Consolidate inventory

No of Locations
The maximum amount of location to display in the popup list.
Note: This parameter is only displayed if the Popup Location  parameter is selected.

Use fixed locations
Select this checkbox to locate the putaway locations that are defined in Infor LN as fixed locations for
the item.
Note: This parameter is only displayed if the Popup Location  parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the available list.
Note: This parameter is only displayed if the Popup Location  parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the available list.
Note: This parameter is only displayed if the Empty Locations  parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are accepted for the items in the available list.
Note: This parameter is only displayed if the Empty Locations  parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory receipts to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item that must
be transferred. Specify the required location.
Note: This parameter is only displayed if the Popup Location  parameter is selected.
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Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first.
Note: This parameter is only displayed if the Consolidate Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all the fixed locations for the item even if they have a quantity of zero.
Note: This parameter is only displayed if the Consolidate Inventory parameter is selected.

Prefill Location
Select this checkbox to specify the Location field. If this parameter is selected, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location putaway location to use for this location.
Note: This parameter is only displayed if the Prefill Locations  parameter is selected.

Default Location
Specify a default putaway location for this transaction.
Note: This parameter is only displayed if the Use Default Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default putaway location for this
transaction. If the item has no fixed locations, the Location field is not specified.
Note: This parameter is only displayed if the Prefill Locations  parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default putaway location.
Note: This parameter is only displayed if the Prefill Locations  parameter is selected.

Consolidate Inventory
Select this checkbox to specify the Location field with the highest or lowest quantity, based on the
selection of the Highest Inventory First parameter for the item.
Note: This parameter is only displayed if the Prefill Locations  parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity.
Note: This parameter is only displayed if the Consolidate Inventory parameter is selected.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from this transaction.

Print Handling Unit Labels before Crossdock
Select this checkbox to print handling unit barcode labels prior to the crossdock transaction.
Note: This parameter is only displayed if the Crossdocking Enabled checkbox is selected parameter is
selected.
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Print Serial Labels before Crossdock
Select this checkbox to print serial number barcode labels prior to the crossdock transaction.
Note: This parameter is available if you select Crossdocking Enabled.

Support Lot Splitting
Select this checkbox, to allow split functionality of a single receipt into multiple lots using the existing
Lot Splitting logic. Clear this checkbox, to retain each receipt to a single lot only.

7 Configure label printing parameters for this transaction on the Order Type Parameters tab, in the
Parameter and Value columns. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

8 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

9 Click Save.

Configuring Release Outbound Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Release Outbound transaction.

1 Select Form > Open > Transaction Set Maintenance form.
2 Select Release Outboundin the Transaction Name column.

Note: If you are configuring parameters that is only applicable for a specific warehouse, the same
warehouse is displayed in the Warehouse field. If you are configuring general parameters, which are
applicable by default throughout the application, the Warehouse field is blank and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Default by Order
Select this checkbox to use the "by order" search method by default. The user can change this method.

Default by Run
Select this checkbox to use the "by run" search method by default. The user can change this method.

Default by Mission
Select this checkbox to use the "by mission" search method by default. The user can change this method.

6 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:
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Check all lines packed
Select this checkbox to prevent users from releasing the outbound if any lines on the advice are not
packed.

Check all lines picked
Select this checkbox to prevent users from releasing the outbound if any lines on the advice are not
picked.

Freeze Shipment
Select this checkbox to freeze shipments that are created when outbounds are released or pick lists are
confirmed.

Confirm Shipment
Select this checkbox to confirm shipments that are created when outbounds are released or pick lists
are confirmed.

Filter by Mission
Select this checkbox to allow users to filter lines by mission when releasing an order.

Filter by Run
Select this checkbox to allow users to filter lines by run when releasing an order.

Print Packing Slip
Select this checkbox to print the packing slip associated with the shipment.

No of Copies
The number of copies to print the packing slip. This parameter is only displayed if the Print Packing
Slip parameter is selected.

Device
The device from which to print the packing slip. This parameter is only displayed if the Print Packing
Slip parameter is selected.

Packing Slip Report
The packing slip report to print. This parameter is only displayed if the Print Packing Slip parameter is
selected.

Print Bill of Lading
Select this checkbox to print the bill of lading associated with the shipment.

No of Copies
The number of copies of the bill of lading to print. This parameter is only displayed if the Print Bill of
Lading parameter is selected.

Device
The device from which to print the bill of lading. This parameter is only displayed if the Print Bill of
Lading parameter is selected.

Bill of Lading Report
The bill of lading report to print. This parameter is only displayed if the Print Bill of Lading parameter
is selected.

Infor Factory Track LN User Guide | 133DRAFT
 

Transaction processing



Release by Item
Select this checkbox to allow users to select an item number so that only the outbound lines related to
the specified item are released.

Display Destination Location
If this checkbox is selected, the destination location of the specified item is displayed.
Note: 
• The location is displayed only for intra-warehouse transfer orders.
• This field is displayed only if the Release by Item checkbox is selected.

7 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

8 Click Save.

Configuring Repacking Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Repacking transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Repacking.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the Order
Type Parameters tab. See Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types for more information.

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.
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Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save.

Configuring Repetitive Time Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Repetitive Time transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Repetitive Time.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Report Inventory Parameters
Use the Transaction Set Maintenance form to configure parameters for the Report Inventory transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Report Inventory.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.
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4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this checkbox to allow users to specify a Reference ID at the beginning of this transaction. For
more information, see Reference IDs on page 16.

Default Shift
The default shift code to record in the production history when users report production quantities. The
user can change this value.

Prefill Quantity from Last Operation
Select this checkbox to use the completed quantity reported from the last operation as the quantity.

Back Flush
Select this checkbox to back flush items when these are reported as completed.

Allow Entry of Reject Quantity
Select this checkbox to allow users to reject quantities.

Default Reason Code
The default reason code for rejections. The user can change this value.
This parameter is only displayed if the Allow Entry to Reject Quantity parameter is selected.

Default Lot Number to Order Number
Select this checkbox to use the order number as the default lot code. The user can change this value.

Allow Over Reporting
Select this checkbox to allow users to complete operation quantities that exceed the quantity specified
on the order.

Prefill Quantity with Open Quantity
Select this checkbox to use the open quantity as the default quantity. The user can change this value.

Report Complete only if Last Operation Complete
Select this checkbox to only allow users to complete production quantities after all operation quantities
are completed.

Default Complete to No
Select this checkbox to automatically specify No as the default value in the Complete field. The user can
change this value.

Allow Entry of Complete Flag
Select this checkbox to specify when an order is completed. Clear this checkbox to complete orders
using the Infor LN interface.

Enter Kanban ID
Select this checkbox to scan a Kanban ID instead of specifying an order number.
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Allow Additional Serials to be Created
Select this checkbox to specify any serial number that is not already assigned. Clear to require the user
to specify serial numbers assigned to the current production order.

Report Production to Inventory
Select this checkbox to receive items into inventory when an order is reported as completed.

Input Package Definition/ Input Package Item
If the Input Package Definition and Input Packaging Item parameters are selected for this transaction,
the Next button is available. Select Next, and specify this package definition information. These
parameters are only displayed, when Report Production to Inventory is selected.

Putaway
Select this checkbox to perform putaway transactions within this transaction. Putaway parameters are
stored at a Group level for consistency but can be copied down to the individual transaction if required.
This parameter is only displayed if the Report Production to Inventory parameter is selected.

Release inbound
Select this checkbox to automatically release inbound orders for put away. This parameter is only
displayed if the Putaway parameter is selected.

Default run no
This parameter is only displayed if the Putaway parameter is selected. This value is always used by the
transaction.

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Putaway parameter is selected.

Use fixed locations
Select this checkbox to only allow users to select putaway locations that are defined in Infor LN as fixed
locations for the item. This parameter is only displayed if the Popup Location parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory receipt to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location.
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Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
This parameter is only displayed if the Highest Inventory First parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.

Default Location
The default putaway location for this transaction. This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default put away location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from within this transaction.

Print Handling Unit Labels before Crossdock
Select to print handling unit barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

Print Serial Labels before Crossdock
Select to print serial number barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.
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6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Report Operation Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Report Operation transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Report Operation.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Reference by Serial
Select this checkbox to allow users to scan a serial number at the beginning of the transaction. Scanning
a serial number automatically specifies the order number, item number, and serial number.

Allow Over Reporting
Select this checkbox to allow users to complete operation quantities that exceed the quantity specified
on the order.

Re-Confirm Completion
Select this checkbox to prompt users to confirm that the users to complete an operation.

Show Pre Operation Qty Reported
Select this checkbox to calculate the open quantity for the current operation based on the quantity
reported for the previous operation.

Show Cumulative Reject Qty
Select this checkbox to display the number of rejected quantities on the order.

User Input Complete Flag
Select this checkbox to allow users to specify when an operation is completed. Clear this checkbox to
complete operations only when the full quantity has been completed.
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Back flush
Select this checkbox to back flush items when these are reported as completed.

Immediately post subassembly to inventory
Select to post subassemblies to inventory immediately after the operation is reported. This parameter
only applies when the current operation precedes a subcontract operation.

Allow Entry of Scrap and Quarantine
Select this checkbox to allow an operator to record the disposition of rejected quantities.

Directly Process Quarantine Inbounding
Select this checkbox to place quarantine stock directly into the quarantine location. This parameter is
only enabled if the Allow Entry of Scrap and Quarantine parameter is selected.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring Report Production Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Report Production transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Report Production.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Reference ID in Use
Select this checkbox to allow users to specify a Reference ID at the beginning of this transaction. For
more information, see Reference IDs on page 16.

Default Shift
Specify the default shift code to record in the production history when users report production quantities.
The user can change this value.
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Prefill Quantity from Last Operation
Select this checkbox to use the completed quantity reported from the last operation as the quantity.

Back Flush
Select this checkbox to back flush items when these are reported as completed.

Allow Entry of Reject Quantity
Select this checkbox to allow users to reject quantities.

Default Reason Code
The default reason code for rejections. The user can change this value. This parameter is only displayed
if the Allow Entry to Reject Quantity parameter is selected.

Default Lot Number to Order Number
Select this checkbox to use the order number as the default lot code. The user can change this value.

Allow Over Reporting
Select this checkbox to allow users to complete operation quantities that exceed the quantity specified
on the order.

Prefill Quantity with Open Quantity
Select this checkbox to use the open quantity as the default quantity. The user can change this value.

Report Complete only if Last Operation Complete
Select this checkbox to only allow users to complete production quantities after all operation quantities
are completed.

Default Complete to No
Select this checkbox to automatically specify No as the default value in the Complete field. The user can
change this value.

Allow Entry of Complete Flag
Select this checkbox to allow users to specify when an order is completed. Clear this checkbox to complete
order using the Infor LN interface.

Enter Kanban ID
Select this checkbox to allow users to scan a Kanban ID instead of specifying an order number.

Allow Additional Serials to be Created
Select this checkbox to specify any serial number that is not already assigned. Clear to require the user
to specify serial numbers assigned to the current production order.

Report Production to Inventory
Select this checkbox to receive items into inventory when an order is reported as completed.

Input Package Definition
Select this checkbox to allow entry of a Handling Unit Package Definition. This parameter is only displayed
if the Report production to Inventory parameter is selected.

Input Packaging Item
Select this checkbox to allow entry of a Handling Unit Packaging Item. This parameter is only displayed
if the Report production to Inventory parameter is selected.
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Putaway
Select this checkbox to allow users to perform put away transactions from within this transaction.
Putaway parameters are stored at a Group level for consistency but can be copied down to the individual
transaction if required. This parameter is only displayed if the Report Production to Inventory parameter
is selected.

Release inbound
Select this checkbox to automatically release inbound orders for put away. This parameter is only
displayed if the Putaway parameter is selected.

Default run no
This parameter is only displayed if the Putaway parameter is selected. This value is always used by the
transaction.

Popup Location
Select this checkbox to allow users to select put away locations from a list instead of scanning them. If
you select this checkbox, you must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.

No of Locations
Tthe maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Use fixed locations
This parameter is only displayed if the Popup Location parameter is selected. Select this checkbox to
only allow users to select put away locations that are defined in Infor LN as fixed locations for the item.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory receipt to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.
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Include all Fixed Locations
This parameter is only displayed if the Highest Inventory First parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Use Default Location
Select this checkbox to specify a default location put away location to use for this location. This parameter
is only displayed if the Prefill Locations parameter is selected.

Default Location
The default put away location for this transaction. This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default putaway location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity.

Crossdocking Enabled
Select this checkbox to allow users to perform cross transactions from within this transaction.

Print Handling Unit Labels before Crossdock
Select to print handling unit barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

Print Serial Labels before Crossdock
Select to print serial number barcode labels before performing the crossdock transaction. This parameter
is available if you select Crossdocking Enabled.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.
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7 Click Save.

Configuring Report Repetitive Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Report Repetitive transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Report Repetitive.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.

Use Default Order Type
Select this checkbox to specify a default order type for this transaction.

Default Order Type
Select this checkbox to use the default order type for this transaction. This parameter is only enabled if
the Use Default Order Type parameter is selected.

Allow Entry of Reject Quantity
Select this check box to allow users to reject quantities.

Reject Code
Specify a default reason code for rejections. This parameter is only enabled if the Allow Entry of Reject
Quantity parameter is selected.

Allow Multiple Lot Numbers to be Reported
Select this checkox to allow users to report multiple lot number items.

Enable Scrap/Quarantine Handling
Select this checkox to allow users to reject quantities.

Default Scrap Reason Code
Specify a default reason for scrapped items. Users can change this value. This parameter is only enabled
if the Enable Scrap/Quarantine Handling parameter is selected.
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Directly process quarantine inbound
Select this checkbox to place quarantine stock directly into the quarantine location. This parameter is
only enabled if the Enable Scrap/Quarantine Handling parameter is selected.

6 Click Save.

Configuring Report Scrap/Quarantine Transaction
Parameters
Use the Transaction Set Maintenance form to configure parameters for the Report Scrap/Quarantine
transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Report Scrap/Quarantine.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.

Directly Process Quarantine Inbounding
Select this checkbox to place quarantine stock directly into the quarantine location.

6 Click Save.

Configuring Reset Employee Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Reset Employee transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Reset Employee.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
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• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Return from Staging Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Return from Staging transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Return from Staging.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Serial Input
Select this checkbox to allow users to scan serial numbers of items being returned.

Default Location
Specify a default location to which to return items.

Handling Units in Use
Select this checkbox to allow users to scan handling units assigned to items being returned.

Default order type for the transaction
Specify a default order type to use to generate the warehouse order.
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Prefill Date
Select this checkbox to automatically specify an inventory date for the returned item if there is only one
inventory date associated with that item at the destination location.

Prefill Lot
Select this checkbox to automatically specify a lot number for the returned item if there is only one lot
number associated with that item at the destination location.

Prefill Warehouse
Select this checkbox to automatically specify the warehouse that contains the destination location.

6 Click Save.

Configuring Return Material Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Return Material transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Return Material.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Handling Unit Input
Select this checkbox to allow users to specify a handling unit instead of specifying the item number and
each stock point characteristic.

Putaway
Select this checkbox to allow users to perform put away transactions from within this transaction.
Putaway parameters are stored at a Group level for consistency but can be copied down to the individual
transaction if required.

Default run no
The default run number for put aways. The user can change this value. This parameter is only displayed
if the Putaway parameter is selected.
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Release inbound
Select this checkbox to automatically release inbound orders for putaway. This parameter is only
displayed if the Putaway parameter is selected.

Prefill Location
Select this checkbox to pre-fill the Location field. If you select this parameter, you must also select one
of these parameters:
• Use Default Location
• Use fixed locations
• Use LN Logic for inbound
• Consolidate Inventory

Consolidate Inventory
Select this checkbox to prefill the location field with either the highest or lowest quantity, depending
upon whether the Highest Inventory First parameter is selected, of the item. This parameter is only
displayed if the Prefill Locations parameter is selected.

Highest Inventory First
Select this checkbox to use the location with the highest quantity of the item as the default location.
Clear this checkbox to use the location with the lowest quantity. This parameter is only displayed if the
Consolidate Inventory parameter is selected.

Use Default Location
This parameter is only displayed if the Prefill Locations parameter is selected. Select this checkbox to
specify a default location put away location to use for this location.

Default Location
The default putaway location for this transaction. This parameter is only displayed if the Use Default
Location parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

Use LN Logic for inbound
Select this checkbox to use Infor LN's inbound advice rules to specify a default putaway location. This
parameter is only displayed if the Prefill Locations parameter is selected.

Popup Location
Select this checkbox to allow users to select putaway locations from a list instead of scanning them.
This parameter is only displayed if the Putaway parameter is selected. Select this checkbox to allow
users to select put away locations from a list instead of scanning them. If you select this checkbox, you
must also select one of these parameters:
• Use fixed locations
• Use empty locations
• Consolidate inventory
This parameter is only displayed if the Putaway parameter is selected.
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No of Locations
The maximum amount of location to display in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Consolidate Inventory
Select this checkbox to direct inventory receipt to existing stocks of the same item. If you select this
parameter, the options list only displays locations containing a positive quantity of the item to be
transferred. Users can still manually specify any location. This parameter is only displayed if the Popup
Location parameter is selected.

Highest Inventory First
Select this checkbox to list locations with the highest quantity of the item first. Clear this checkbox to
list locations with the lowest quantity of the item first. This parameter is only displayed if the Consolidate
Inventory parameter is selected.

Include all Fixed Locations
Select this checkbox to list all fixed locations for the item even if they have a quantity of zero. This
parameter is only displayed if the Consolidate Inventory parameter is selected.

Use Empty Locations
Select this checkbox to display empty locations in the popup list. This parameter is only displayed if the
Popup Location parameter is selected.

Check Capacity
Select this checkbox to only display locations with sufficient capacity in the popup list. This parameter
is only displayed if the Empty Locations parameter is selected.

Check Storage Locations
Select this checkbox to only display locations that are acceptable for the item in the popup list. This
parameter is only displayed if the Empty Locations parameter is selected.

Use fixed locations
Select this checkbox to use the first fixed location of the item as the default put away location for this
transaction. If the item has no fixed locations, the Location field is not specified. This parameter is only
displayed if the Prefill Locations parameter is selected.

6 Click Save.

Configuring Sealing Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Sealing transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Sealing.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
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• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse
is displayed in the Warehouse field.

• If you are configuring general parameters, which are applicable by default in the application, the
Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Print Labels via EXM
Select this field to print labels using the EXM application and not using the standard Bartender logic.

Freeze Shipment Lines
Select this checkbox to automatically freeze shipment lines associated with a package when sealed,
and unfreeze lines when a package is unsealed.

Asset Tag
Select this checkbox to allow the Asset Tag to be updated on the Handling Unit that is sealed.

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save.

Configuring Shipment Handling Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Shipment Handling transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Shipment Handling.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these order type-specific parameters on the Order Type Parameters tab, in the Parameter
and Value columns:

Confirm Shipment Allowed
Select this checkbox to allow users to confirm shipments.

Reject if any Lines are not Loaded
Select this checkbox to prevent users from confirming shipments if any lines are not loaded. This
parameter is only displayed if the Confirm Shipment Allowed parameter is selected.

Warn if any Lines are not Loaded
Select this checkbox to give a warning when an attempt is made to confirm a shipment where some
lines have not yet been loaded. This parameter is only displayed if the Confirm Shipment Allowed
parameter is selected.

Freeze Shipment Allowed
Select this checkbox to allow users to freeze shipments.

Reject if any Lines not Packed
Select this checkbox to prevent users from freezing shipments if they are not packed. This parameter is
only displayed if the Freeze Shipment Allowed parameter is selected.

Warn if any Lines not Packed
Select this checkbox to give a warning when an attempt is made to freeze a shipment where some lines
have not yet been packed. This parameter is only displayed if the Freeze Shipment Allowed parameter
is selected. 

Allow Shipment to be Unfrozen
Select this checkbox to allow users to unfreeze shipments.

Print Packing Slip
Select this checkbox to print the packing slip associated with the shipment.

No of Copies
The number of copies of the packing slip to print. This parameter is only displayed if the Print Packing
Slip parameter is selected.

Packing Slip Report
The packing slip report to print. This parameter is only displayed if the Print Packing Slip parameter is
selected. 

Print Bill of Lading
Select this checkbox to print the bill of lading associated with the shipment.

No of Copies
The number of copies of the bill of lading to print. This parameter is only displayed if the Print Bill of
Lading parameter is selected.
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Bill of Lading Report
The bill of lading report to print. This parameter is only displayed if the Print Bill of Lading parameter
is selected. 

6 Specify this information for each order type on the Order Types tab:

Enabled
Select this checkbox to allow this order type to be used in this transaction.

Specific Parameters
Select this checkbox to use order-specific parameter settings for this order type. Clear this checkbox to
use the default parameter settings for this order type.

7 Click Save.

Configuring Split Handling Unit Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Split Handling Unit transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Split Handling Unit.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

6 Click Save.

Configuring Start/Stop Shift Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Start/Stop Shift transaction.
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1 Go to Transaction Set Maintenance form > Transaction Name > Start/Stop Shift.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Default Shift
The default shift code for this transaction. The user can change this value.

Calculate Production Machine Hours based on Machine Occupation
When an employee ends their shift, all active jobs linked to that employee are automatically stopped.
Select this check box to calculate the effective machine hours for stopped production operations based
on the machine occupation settings defined for that operation.

Calculate PCS Machine Hours based on Machine Occupation
When an employee ends their shift, all active jobs linked to that employee are automatically stopped.
Select this check box to calculate the effective machine hours for stopped PCS projects based on the
machine occupation settings defined for that PCS project.

6 Click Save.

Configuring Task Details Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Task Details transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Task Details.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure this parameter on the Transaction Parameters tab, in the Parameter and Value columns.

Create As-Built Record
Select this checkbox to allow users to create as-built records even if not required by the order.

Create Lot Number
Select this checkbox to allow users to create lot numbers. Clear this checkbox to use existing lot numbers.

Create Serial Number
Select this checkbox to allow users to create serial numbers. Clear this checkbox to use existing serial
numbers.

6 Configure label printing parameters for this transaction on the Order Type Parameters tab, in the
Parameter and Value columns. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.

Configuring TT Break In/Out Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the TT Break In/Out mobile scanner
transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > TT Break In/Out.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Duplicate Protection (HH:MM:SS)
Use this parameter to prevent duplicate transactions. Using the HH:MM:SS format, specify the maximum
duration after a transaction that the submission of the same transaction is considered a duplicate. For
example, if you specify a value of 00:01:00, and a user performs two clock-in transaction within a minute
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of each other, the second clock-in transaction is considered a duplicate. When a duplicate transaction
occurs, the user is notified and asked whether to process or cancel the transaction.

6 Click Save.

Configuring TT Clock In/Out Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the TT Clock In/Out mobile scanner
transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > TT Clock In/Out.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Format is HH:MM:SS (Duplicate Protection)
Use this parameter to prevent duplicate transactions. Using the HH:MM:SS format, specify the maximum
duration after a transaction that the submission of the same transaction is considered a duplicate. For
example, if you specify a value of 00:01:00, and a user performs two clock-in transaction within a minute
of each other, the second clock-in transaction is considered a duplicate. When a duplicate transaction
occurs, the user is notified and asked whether to process or cancel the transaction.

6 Click Save.

Configuring TT Job Booking Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Job Booking transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > TT Job Booking.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
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Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Allow Indirect Job
Specify 1 to allow employees to start indirect tasks using this transaction. Specify 0 to prevent employees
from starting indirect tasks using this transaction.

6 Click Save.

Configuring TT Lunch In/Out Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the TT Lunch In/Out mobile scanner
transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > TT Lunch In/Out.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Duplicate Protection (HH:MM:SS)
Use this parameter to prevent duplicate transactions. Using the HH:MM:SS format, specify the maximum
duration after a transaction that the submission of the same transaction is considered a duplicate. For
example, if you specify a value of 00:01:00, and a user performs two clock-in transaction within a minute
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of each other, the second clock-in transaction is considered a duplicate. When a duplicate transaction
occurs, the user is notified and asked whether to process or cancel the transaction.

6 Click Save.

Configuring TT Time and Attendance Transaction
Parameters
Use the Transaction Set Maintenance form to configure parameters for the TT Time and Attendance mobile
scanner transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > TT Time and Attendance.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Unlink Handling Unit Transaction Parameters
Use the Transaction Set Maintenance form to configure parameters for the Unlink Handling Unit transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Unlink Handling Unit.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.
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3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Click Save.

Configuring Unplanned Material Issue Parameters
Use the Transaction Set Maintenance form to configure parameters for the Unplanned Material Issue
transaction.

1 Go to Transaction Set Maintenance form > Transaction Name > Unplanned Material Issue.
2 Select Fill Warehouse checkbox to pre-fill the warehouse on the transaction with the warehouse assigned

to the user.
Note: 
• You can change this warehouse for a specific transaction if required.
• If you are configuring parameters that only applicable for a specific warehouse, the same warehouse

is displayed in the Warehouse field.
• If you are configuring general parameters, which are applicable by default in the application, the

Warehouse field is unspecified and unavailable.

3 Select Successful Message checkbox to display a success message when the transaction is successfully
completed.

4 Select a Default Order Type for this transaction from the available values.
Note: You can change this value.

5 Configure these parameters on the Transaction Parameters tab, in the Parameter and Value columns:

Generate Outbound
Select this checkbox to generate an outbound allocation when materials are issued.

Release Outbound
Select this checkbox to release the outbound allocation when materials are issued.

6 Select Label Print Parameters to configure label printing parameters for this transaction on the
Transaction Parameters tab. See Configuring Label Printing Settings for Specific Transactions,
Warehouses, and Order Types for more information.

7 Click Save.
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Configuring Transaction Parameters for Specific Order
Types
Use the Transaction Set Maintenance form to configure transaction parameters for specific order types. You
can configure order-type specific parameters that apply to a transaction throughout the application, or you
can configure order-type specific parameters that only apply to a transaction that when it is run in a specific
warehouse.

Note: Only certain types of transactions support the concept of different order types. Also, the Order types
Tab allows certain types of order to get enabled or disabled for that transaction.

1 To configure order-type specific parameters that apply to a transaction throughout the application, open
the Transaction Set Maintenance form. To configure order-type specific parameters for a transaction
that only apply in a specific warehouse, open the Warehouse Parameters form, select the warehouse,
select the transaction, and click Specific Parameter Settings. The transaction you select must be
configured for warehouse-specific parameters. For more information about configuring transactions to
have warehouse-specific parameters, see Configuring Transaction Parameters for Specific Warehouses
on page 160.

2 Select a transaction from the grid. If you are configuring parameters for a specific warehouse, a transaction
is automatically selected.

3 On the Order Types tab, select Specific Parameters for the order type you are configuring. You are
prompted to copy parameters to the order type, click OK. The parameters values currently set on the
Order Type Parameters tab are copied for this order type. The copied values are no longer linked to the
values on the Order Type Parameters tab, they now exist as a separate set of values for this specific
order type for this transaction.

4 To change parameter values for this specific order type, ensure that the order type is selected, and select
Specific Parameter Settings. The Order Type Specific Parameters form is displayed.

5 Configure the parameters on the Order Type Specific Parameters form. Any changes you make to these
parameter values will only affect this order type. For more information about how to configure individual
parameters, see Transaction Set Maintenance.

6 Optionally, to configure label printing parameters that are specific to this order type, select Label Print
Parameters. The Transaction Warehouse Order Type Print Parameters form is displayed. Configure the
parameters on this form as desired and save your changes. For more information about how to configure
label printing parameters, see Configuring Label Printing Settings for Specific Transactions, Warehouses,
and Order Types.

7 Click Save and close the Order Type Specific Parameters form.
8 Click Save to save your changes made on the Transaction Set Maintenance form.
9 If the check box is cleared, the application prompts a message to delete the order type parameters. Click

Yes, to delete the selected parameter.
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Configuring Transaction Parameters for Specific
Warehouses
Use the Warehouse Parameters form to configure transaction parameters for specific warehouses.

1 Open the Warehouse Parameters form.
2 To configure parameters for an existing warehouse, select it from the Whse grid column. To configure

parameters for a new warehouse, select an empty line from the Whse grid column and specify a warehouse
code and description in the Warehouse fields.

3 On the Transactions tab, select all transactions that will have parameter values specific to this warehouse.
Any transactions that have the Warehouse Specific check box selected are already using
warehouse-specific parameters.

4 To copy the general transaction parameter values currently configured for the transaction on the
Transaction Set Maintenance form, select Copy From Template. A separate copy of these transaction
values will be created for the warehouse. These copied parameter values are only the initial values used
for the warehouse, you can change them as needed for the warehouse. The warehouse-specific copy of
these parameters will no longer be linked to the general transaction parameter values, so any changes
you make to the warehouse-specific parameter values will not affect the general transaction parameter
values and vice versa. To copy parameter values from another warehouse instead of the general transaction
parameter values, clear the Copy from Template box and, in theFrom field, select the warehouse from
which you are copying values.

5 To use warehouse-specific parameters for this warehouse for all selected transactions, select Copy
Selected Transactions to Warehouse. Optionally, to use warehouse-specific parameters for this
warehouse for all transactions, select Copy All Transactions to Warehouse.

6 Click Save.
7 To configure warehouse-specific parameter values for a specific transaction, select the transaction and

select Specific Parameter Settings. The Transaction Set Maintenance form is displayed.
8 Configure warehouse-specific parameter values for this transaction. The warehouse for which you are

configuring parameters is displayed in the Warehouse field, indicating that any changes you make to
the parameter values on this form will only apply to that warehouse.  For more information about how
to configure individual parameters on this form, see Transaction Set Maintenance.

9 Optionally, to configure label printing parameters for this transaction that are specific to this warehouse,
select Label Print Parameters. The Transaction Warehouse Order Type Print Parameters form is displayed.
Configure the parameters on this form as desired and save your changes. For more information about
how to configure label printing parameters, see Configuring Label Printing Settings for Specific
Transactions, Warehouses, and Order Types.

10 Click Save.
11 If the check box is cleared, the application prompts a message to delete the warehouse specific parameters.

Click Yes, to delete the selected parameter.
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